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Change Log

Change Log

The following Change Log explains by Product Version, Heading, Page, and Reason where
changes in the ProgressBook Studentinformation EZ Query Guide have been made.

Product .

Version Heading Page

18.2.0 “Compare Student's Home 24
School and JVS Data”

18.1.0 “Compare Student's Home 24
School and JVS Data”

18.1.0 “SIS Student Search” 66

18.0.0 “SIS Student Search” 66

Reason
Updated the Shared Student Data — EMIS - FS image
to reflect removed fields.

Updated images and text to reflect new Shared Student
Data screen name and information displayed.

Updated images and text to reflect new parameter set
feature.

Updated field names to match new names.
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Overview

Overview

The EZ Query menu provides access to Studentinformation data in read-only format.

Note: If you have the job function of Teacher in Studentinformation security, you
can see data for your students (assigned to your course sections). In order to see
other students, if you have the Teacher job function, any other job function, or no
job function assigned, your user account must be set up either with the associated
staff member impersonations or the option to Allow Staff Members to view all
Students in EZ Query in order for you to see this data. For more information, see
the ProgressBook Studentinformation Security Guide.

» To view data for a single student, see “Individual Student Data.”
* To view classroom management resources, see “Tools.”
e To view reports, see “Reports.”
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Individual Student Data

Individual Student Data

EZ Query’s EZ Students screens let you view data for an individual student.

Note: If you have the job function of Teacher in Studentinformation security, you
can see data for your students (assigned to your course sections). In order to see
other students, if you have the Teacher job function, any other job function, or no
job function assigned, your user account must be set up either with the associated
staff member impersonations or the option to Allow Staff Members to view all
Students in EZ Query in order for you to see this data. For more information, see
the ProgressBook Studentinformation Security Guide.

Refer to the appropriate topic as follows:

“View Student’s Attendance”

“View Student’s Contacts”

“View Student’s Course History”

“View Student’s Course Requests”

“View Student’s Demographic Data”

“View Student’s Discipline Records”

“View Student’s EMIS Reportable Data”

“View Student’s Enrollment History”

“View Student’s School Medical Records”

“View Student’s Memberships and Special Education Services”
“View Student’s Schedule”

“Compare Student’s Home School and JVS Data”
“View Student’'s Fees”

“View Student’s Marks”

View Student’s Attendance

Note: For detailed information about student attendance, see the ProgressBook
StudentInformation Attendance and Calendar Guide.

Navigation: Studentinformation — EZ Query — EZ Students — Attendance

With a student in context, the Attendance screen displays the student’s overall attendance rate
and attendance incidents broken out by attendance code in both pie chart and table format.

To view the student’s absence history for previous school years and buildings, click View
Absence History.

ProgressBook Studentinformation EZ Query Guide 2



Individual Student Data

Studentinformation > EZ Query > EZ Students > Attendance

Attendance

‘ View Absence History ‘

Attendance Rate

Attendance Rate

Totals

Description  Value
Present

449 % Days -

Present Days 163.50
1.40 % ® FiCUSED
2.25 % EXCUSED 8.00

UNEXCLSED -
®,

UMEXCUSED 2.50
la1 .85 % YQCATION

VACATION 400

Date Type AM/PM Comment Reason Note
Sep 23, 2015 EXCUSED Religious Holiday

Sep 24, 2015 EXCUSED Religious Holiday

Sep 29, 2015 PERMIT TO LEAVE PM

Dec 01, 2018 EXCUSED PM

Dec 16, 2016 EXCUSED Out of Town

Dec 21, 2015  PERMIT TO LEAVE = PM

Dec 22, 2015 UNEXCUSED Vacation (Not Pre-Arranged)
Jan 07,2016 EXCUSED PM

Feb 04, 2016 EXCUSED PM

Feb 05, 2016 UNEXCUSED PM

Mar 17, 2016 EXCUSED

Apr 05, 2016 = UNEXCUSED

Apr 21,2016 EXCUSED PM

Apr 26, 2016 = EXCUSED

May 12, 2016 EXCUSED

Jun 03, 2016 VACATION

Jun 06, 2016 VACATION

Jun 07, 2016 = VACATION

Jun 08, 2016  VACATION

19 Records Displayed Back To Top
Attendance Incidents

Attendance Incidents
Totals

Ferfect Description Absence Type Total
5.62 % L Days -
ERCUSED Perfect Days 159
112 % S
69 % J—— EXCUSED A 10
225 % ® TO LEAVE -

! PERMIT TO LEAVE  J 2
UMNEXCUSED -
Y UNEXCUSED u 3

89.33 %
WACATION
-

VACATION X 4
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Individual Student Data

Absence History

Studentinformation > EZ Query = EZ Students > Attendance

Attendance

‘ Return To Aftendance

School Year School Days Attended Days Absent Excused Days Absent Unexcused Days Partial

2015-2016 172.00 5.00 0.00 13.00

View Student’s Contacts

Note: For detailed information about student contacts, see the ProgressBook
Studentinformation Student and Registration Guide.
Navigation: Studentinformation — EZ Query — EZ Students — Contact

1. With a student in context, on the Contact screen drop-down list, select the format in which
you want to display information about the student’s contacts.

2. (Optional) If you want this screen to default to your display format selection each time, click
Set As Default.

Studentinformation = EZ Query = EZ Students > Contact

Contact

Select a Display Format From List:

|AddressLabels  |v

AddressLabels
AddressLine
AddressLine2

Set As Default

ExpandedAddress
AddressLabelsLocal
A3 T

The contact information displays based on the display format you selected as follows:

ProgressBook Studentinformation EZ Query Guide 4



Individual Student Data

Display Format — AddressLabels

Studentinformation = EZ Query > EZ Students > Contact

Contact

Select a Display Format From List:

AddressLabels B Set As Default

Primary

Amy Jones

6770 West Snowville Road
Brecksville, OH 44141
(555) 555-5555

Matthew Jones

6770 West Snowville Road
Brecksville, OH 44141
(555) 555-5555

Relative

Brianne Jones

6770 West Snowville Road
Brecksville, OH 44141
(555) 555-5555

ProgressBook Studentinformation EZ Query Guide



Display Format — AddressLine

Studentinformatio

Contact

Type:

Name:
Address:

City, State Zip:
Telephone:

Email Address:

Type:

Name:
Address:

City, State Zip:
Telephone:

Email Address:

Type:

Name:
Address:

City, State Zip:
Telephone:

Email Address:

> EZ Students = Contact

Select a Display Format From List:

AddressLine B Set As Default

Primary

Amy Jones

6770 West Snowville Road
Brecksville, OH 44141
(555) 555-5555

FakeAddress@Software-Answers.com

Matthew Jones
6770 West Snowville Road
Brecksville, OH 44141

(550) 555-5555

Relative

Brianne Jones

6770 West Snowville Road
Brecksville, OH 44141
(555) 555-5555

FakeAddress@Software-Answers.com

Individual Student Data
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Individual Student Data

Display Format — AddressLine2

Studentinformation > EZ Query > EZ Studen

Contact

Select a Display Format From List:

AddressLine2 B Set As Default

Type: Primary

MName: Amy Jones

Address: 6770 West Snowville Road

City, State Zip: Brecksville, OH 44141

Telephone: (555) 555-5555

Email Address: FakeAddress@Software-Answers.com
Type:

Name: Matthew Jones

Address: 6770 West Snowville Road

City, State Zip: Brecksville, OH 44141

Telephone: (555) 555-5555

Email Address:

Type: Relative

Name: Brianne Jones

Address: 6770 West Snowville Road

City, State Zip: Brecksville, OH 44141

Telephone: (555) 555-5555

Email Address: FakeAddress@Software-Answers.com

Display Format — AddressLineGrid

Studentinformation = EZ Query = EZ Students > Contact

Contact

Select a Display Format From List:
AddressLineGrid B Set As Default

Type Name Address

Primary =~ Amy Jones B770 West Snowville Road  Brecksville, OH 44141 (555) 555-5555 FakeAddress@Software-Answers.com
Matthew Jones =~ 6770 West Snowville Road = Brecksville, OH 44141 = (555) 555-5555

Relative Brianne Jones 6770 West Snowville Road Brecksville, OH 44141 (555) 555-5555 FakeAddress@Software-Answers.com

City, State Zip Telephone Email Address
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Display Format — ExpandedAddress

Studentinformation = EZ Query > EZ Students > Contact

Contact

Type:

Mame:

House Number:
Street Direction:
Street Name:

Street Type:
Apartment - PO Box:
Complex:

City. State Zip:
Telephone:

Email Address:

Type:

Mame:

House Number:
Street Direction:
Street Name:

Street Type:
Apartment - PO Box:
Ccomplex:

City, State Zip:
Telephone:

Email Address:

Select a Display Format From List:

ExpandedAddress -~ @SSRS ETE

Primary

Amy Jones

Brecksville, OH 44141
(555) 555-5555

FakeAddress@sSoftware-Answers.com

Matthew Jones

Brecksville, OH 44141

(555) 555-5555

Individual Student Data
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Individual Student Data

Display Format — AddressLabelsLocal

Studentinformation > EZ Query = EZ Students > Contact

Contact

Select a Display Format From List:

AddressLabelsLocal ~ [ RN EEN]

Primary

Amy Jones

6770 West Snowville Road
Brecksville, OH 44141
5555555555

Matthew Jones

6770 West Snowville Road
Brecksville, OH 44141
5565555555

Relative

Brianne Jones

6770 West Snowville Road
Brecksville, OH 44141
5565555555

View Student’s Course History

Note: For detailed information about student course history, see the
ProgressBook Studentinformation Course History, Class Rank, and Transcripts

Guide.

Navigation: Studentinformation — EZ Query — EZ Students — Course History

1.

With a student in context, on the Course History screen drop-down list, select the format
in which you want to display information about the student’s course history.

(Optional) If you want this screen to default to your display format selection each time, click

Set As Default.

Studentinformation = EZ Query > EZ Students = Course History

Course History

Select a Display Format From List:

CourseHistoryGradesGrid

CourseHistoryGradesGrid

CourseHistoryGradesGridFinal

CourseHistoryMainGrid

Set As Default
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Individual Student Data

The course history information displays based on the display format you selected as

follows:

Display Format — CourseHistoryGradesGrid

Studentinformation = EZ Query = EZ Students > Course History

Course History

Select a Display Format From List:

‘ CourseHistoryGradesGrid

b4 Set As Default

Grade School Year

9 2014

Mark Type Mark
GP A
GP
EX
AVG
GP
GP
EX

AVG

> r Fr r r r »r ¥

FIN

Grade School Year

9 2014

Mark Type Mark
GP B
GP B

EX
AVG
GP
GP
EX

AVG

> > »r r r W ¥

FIN

Course Name Course Section School

DECISIONS IN LIVING 28 DOHS

Absences Attempted Credit Earned Credit

0.00 0.25 0.25

0.00 0.25 0.25

0.00 0.00 0.00

0.00 0.50 0.50

0.00 0.25 0.25

0.00 0.25 0.25

0.00 0.00 0.00

0.00 0.50 0.50

0.00 1.00 1.00
Course Name Course Section School
ENGLISH 9 28 DOHS

Absences Attempted Credit Earned Credit

0.00 0.25 0.25
0.00 0.25 0.25
0.00 0.00 0.00
0.00 0.50 0.50
0.00 0.25 0.25
0.00 0.25 0.25
0.00 0.00 0.00
0.00 0.50 0.50
0.00 1.00 1.00

ProgressBook Studentinformation EZ Query Guide
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Individual Student Data

Display Format — CourseHistoryGradesGridFinal

Studentinformation = EZ Query > EZ Students > Course History

Course History

Select a Display Format From List:

| CourseHistoryGradesGridFinal ~
Grade School Year Course Name Course Section
9 2014 DECISIONS IN LIVING 28
9 2014 ENGLISH 9 28
9 2014 HEALTH & 30
9 2014 WORLD HISTORY 29
9 2014 PRE-ALGEBRA 20
9 2014 ORCHESTRAI 25
9 2014 PHYSICAL SCIENCE | 26
9 2014 SPANISH 1 21
10 2015 TOWARD INDEPENDENCE 28
10 2015 AMERICAN LITERATURE 29
10 2015 AMERICAN HISTORY 30
10 2015 ALGEBRA 27
10 2015 ORCHESTRAIl 27
10 2015 PHYSICAL EDUCATION 201 | 27
10 2015 BIOLOGY 26
10 2013 SPANISH 2 24
11 2016 ACCOUNTING | 27
11 2016 ENGLISH Il 27
11 2016 GEOMETRY 28
11 2016 ORCHESTRAI 21
11 2016 CHEMISTRY 24
11 2016 GOVERNMENT 26
11 2016 SPANISH 3 23
12 2017 COMPUTER APPLICATION | 21
12 2017 ECONOMICS 22
12 2017 COMPOSITION 27
12 2017 ALGEBRA Il 22
12 2017 ORCHESTRA IV 27
12 2017 MICROBIOLOGY 27

School

DOHS

DOHS

DOHS

DOHS

DOHS

DOHS

DOHS

DOHS

DOHS

DOHS

DOHS

DOHS

DOHS

DOHS

DOHS

DOHS

DOHS

DOHS

DOHS

DOHS

DOHS

DOHS

DOHS

DOHS

DOHS

DOHS

DOHS

DOHS

DOHS

Mark Type Mark Absences Afttempted Credit Eamed Credit

11
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Display Format — CourseHistoryMainGrid

Studentinformation = EZ Query > EZ Students = Course History

Course History

Select a Display Format From List:

| CourseHistoryMainGrid v
Grade School Year Course Name Course Section  School
9 2014 DECISIONS IN LIVING 28 DOHS
9 2014 ENGLISH 9 28 DOHS
9 2014 HEALTH 9 30 DOHS
9 2014 WORLD HISTORY 29 DOHS
9 2014 PRE-ALGEBRA 29 DOHS
9 2014 ORCHESTRA| 25 DOHS
9 2014 PHYSICAL SCIENCE | 26 DOHS
9 2014 SPANISH 1 21 DOHS
10 2015 TOWARD INDEPENDENCE 28 DOHS
10 2015 AMERICAN LITERATURE 29 DOHS
10 2015 AMERICAN HISTORY 30 DOHS
10 2015 ALGEBRA | 27 DOHS
10 2015 ORCHESTRAIl 27 DOHS
10 2015 PHYSICAL EDUCATION 201 | 27 DOHS
10 2015 BIOLOGY 26 DOHS
10 2015 SPANISH 2 24 DOHS
kil 2016 ACCOUNTING | 27 DOHS
" 2016 ENGLISH Il 27 DOHS
" 2016 GEOMETRY 28 DOHS
1 2016 ORCHESTRA I 21 DOHS
" 2016 CHEMISTRY 24 DOHS
" 2016 GOVERNMENT 26 DOHS
" 2016 SPANISH 3 23 DOHS
12 2017 COMPUTER APPLICATION 21 DOHS
12 2017 ECONOMICS 22 DOHS
12 2017 COMPOSITION 27 DOHS
12 2017 ALGEBRA Il 22 DOHS
12 2017 ORCHESTRA IV 27 DOHS
12 2017 MICROBIOLOGY 27 DOHS

Individual Student Data

ProgressBook Studentinformation EZ Query Guide
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Individual Student Data

View Student’s Course Requests

Note: For detailed information about student course history, see the
ProgressBook Studentinformation Scheduling Guide.
Navigation: Studentinformation — EZ Query — EZ Students — Course Requests

With a student in context, the Course Requests screen displays the student’s current course
requests.

Studentinformation > EZ Query > EZ Students > Course Requests [Find Students] H:—; To] ) C

Course Requests

School Year Course Course Name Priority CreditUnits Grade Alternate Course Assigned Course Assigned Section Status

2016-2017 145 AMERICAN HISTORY 8 1.000000 09 145 4 Approved
2016-2017 340 ALGEBRA | 9 1.000000 09 340 70 Approved
2016-2017 885 HEALTH 9 0.500000 09 885 22 Approved
2016-2017 742 FRENCH Il 9 1.000000 09 742 3 Approved
2016-2017 855 CONCERT CHOIR 9 1.000000 09 855 1 Approved
2016-2017 242 PHYSICAL SCIENCE Il 8 0.500000 09 242 22 Approved
2016-2017 039 ENGLISH 9 9 1.000000 09 039 -3 Approved
2016-2017 241 PHYSICAL SCIENCE| 8 0.500000 09 241 51 Approved
2016-2017 079 DRAMATICS 9 0.500000 09 079 21 Approved

View Student’s Demographic Data

Note: For detailed information about student demographics, see the
ProgressBook Studentinformation Student and Registration Guide.
Navigation: Studentinformation — EZ Query — EZ Students — Demographic

With a student in context, the Demographic screen displays the student’s picture, basic
demographic data, and admission data.

13 ProgressBook Studentinformation EZ Query Guide



Studentinformation > EZ Query > EZ Students > Demographic

Demographic
Address: 1361 North Ave
SADoc, OH 44320-0000
Phone: (440) 433-8700
Unlisted: Yes

Primary Student Contact: = Maldonado, Stephanie

Contact Type: Mother

Gender: FEMALE

Birthdate: 07/16/2000

Counselor:

EMIS Situation: 5 - Resident attending Full Time
Grade: 12

School Year: 2017-2018

Homeroom: DOHS106 Wallace_Albert
Disability Condition: =

Program Code:

Locker:

Locker Combination:

District of Residence IRN: 300430

Diploma Date:
Ethnicity: w
Schedule Priority: a]
20 Records Displayed Back To Top

2015-2016 Jul01, 2015 1

2016-2017 Jul01, 2016 1

2017-2018 Jul 01, 2017 1

School Year Admitted Admission Code Withdrew Withdraw Code Withdrew To

Individual Student Data

Admitted From Calendar
HS Default 2015
HS Default 2016

HS Default 2017

ProgressBook Studentinformation EZ Query Guide
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Individual Student Data

View Student’s Discipline Records

Note: For detailed information about discipline, see the ProgressBook
StudentIinformation Discipline Guide.

Navigation: Studentinformation — EZ Query — EZ Students — Discipline

With a student in context on the Discipline screen, review the student’s discipline data.

Studentinformation > EZ Query > EZ Students > Discipline Find Students] __ @RliGo To
Discipline
Incident Number: 122649 MName: Test Date: 04/03/2017 Building: Ashland High School Grade: 09 Homeroom: -
Referred By: JARED FITZPATRICK (Staff) Place: On School Property Location: GYM Needs Letter: No Against Property: No

Description: Tesfing

Infraction Policy Policy/Infraction Comment

Caught smoking RULE 6-TOBACCO.ALCOHOL DRUGS

Action Start Date End Date Duration Demerits Served Modified Expulsion Received Services Action Comment
In-School Suspension 1.50 Yes No No

Parent Involvement Name Address Phone Email Date Parent Involvement Comment

There are no records to display

View Student’s EMIS Reportable Data

Note: EMIS reportable data for years prior to FY09 is not available on this screen.

Note: For detailed information about student EMIS reportable data, see the
ProgressBook Studentinformation Student and Registration Guide.

Navigation: Studentinformation — EZ Query — EZ Students — EMIS Demographic

With a student in context, on the EMIS Demographic screen, in the Choose data to view
drop-down list, select the type of EMIS data you want to display for the student. The selections,
with the exception of EMIS - Student, are based on student profile tabs containing EMIS
reportable data.
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The EMIS information displays based on your selection as follows:

Individual Student Data

EMIS Reportable Data — From FS - Standing Tab of Profile

Studentinformation EZ Students > EMIS Demographic

EMIS Demographic

From this screen users can view a student's EMIS data.

Choose data to view: FS - Standing  ~

FS Standing List:

SentTo SentTo%

Start Withdraw Withdraw EMIS District District Of How How Percent Attending Sent To
Date Date Reason Situation Relationship Residence Received ReceivedIRN Of Time BuildingIRN Reason1 IRN1
Q 71/2016 = 5 1 043505 * Fr 100 001081 NA ks
FS Standing Detail:
Effective Start Date: 7/M/2016
EMIS ld: A2T696797 State Student Id: 0Y3639633
District Admission Date:11/30/2005 Admission Reason: 7 - Not newly enrolled in this school district
Admitted From IRN: e Withdraw Reason: ** - Not Applicable, Did not withdraw/was not truant
District Withdraw Date:
Withdrawn To IRN: ik
EMIS Situation: 5 - 5 - Resident attending Full Time
District Relationship: 1 - Stud. revg insir. in whole/part from rep. distDistrict of Residence: 043505 - Ashland City SD
How Received: * - Not Applicable How Received IRN: =
Percent of Time: 100 Tuition Type: N - Non-tuition student (default)
Attending Building IRN: 001081 - Ashland High School Assigned Building IRN:=*=*
County of Residence: 03 - Ashland
SentTo 1 Sent To 2
Reason: NA - Not sent to another district Reason: NA - Not sent to another district
IRN: J— IRN:
Percent of Time: 0 Percent of Time: 0

Of Time 1

EMIS Reportable Data — From FS - Attendance Tab of Profile

EZ Query > EZ Students > EMIS Demograpl

EMIS Demographic

From this screen users can view a student's EMIS data.

Choose data to view:| FS - Attendance ~

FS Attendance List:

School
OctCcW Oct CW Year School Year
Oct CW Excused Unexcused School Year Excused Unexcused
Start Withdraw Withdraw Attendance Absence Absence Attendance  Absence Absence
Date Date Reason  Days Days Days Days Days Days
Q 711/2016 = 0.00 0.00 0.00 177.00 0.00 0.00

F$ Attendance Detail:

District Withdraw Date:

Effective Start Date:7/1/2016
District Withdraw Reason:** - Not Applicable, Did not withdraw/was not truant

October Count Week
Attendance Days: 0.00
Excused Absence Days: 0.00
Unexcused Absence Days:0.00
Non-Attending Reason:

School Year Other Entity School Year

Attendance Days: 177 00Attendance Days: 0.00
Excused Absence Days: 0.00 Excused Absence Days: 0.00
Unexcused Absence Days:0.00 Unexcused Absence Days:0.00

Other 5Y
Attendance
Days

0.00

Other SY
Excused

Absence
Days

0.00

Other SY
Unexcused
Absence
Days

0.00

ProgressBook Studentinformation EZ Query Guide
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Individual Student Data

EMIS Reportable Data — From FD - Attributes Tab of Profile

Studentinformation > EZ Query > EZ Students > EMIS Demographic [Find Students (G E

EMIS Demographic

From this screen users can view a student's EMIS data.

Choose data to view:| FD - Atiributes ~ ~

FD Attributes List:

Start Withdraw Withdraw St. Eq. Gr. Free/Reduced Migrant Immigrant Preschool
Date Date Reason Level Disahility 504 Plan Disadvantagement Lunch LEP Status Status Poverty
Q 7112016 = 10 = Y 1 None N N N N

FD Attributes Detail:

Effective Start Date: TMr2016

District Withdraw Date: Withdraw Reasen: = - Not Applicable, Did not withdraw/was not truant

State Equivalent Grade Level: 10 - Tenth Grade

Disability Condition: ** - Mot Applicable Section 504 Plan: Y - Yes

Disadvantagement: 1 - Economic Disadvantagement Free / Reduced Lunch Status:  None

Limited English Proficiency: N - No, the student is not of Limited English ProficiencyLEP Reclass Date:

Homeless Status: * - Not Applicable Homeless Unaccompanied Youth:N - No

Migrant Status: N - No Immigrant Status: N - No

Foreign Exchange Graduation Plan® - Not Applicable - not a foreign exchange student

Reporting Calendar: (DFLT) Default Preschool Poverty Level: N - Not a Preschool student

Attendance Pattern: - Mot Applicable

EMIS Reportable Data — From FN - Attributes Tab of Profile

Studentinformation > EZ Query > EZ Students > EMIS Demographic i ] [Go Tol ) Q)

EMIS Demographic

From this screen users can view a student's EMIS data.

Choose data to view: FN - Attributes -~

FN Attributes Detail:
EMIS Grade Next Year: GR - Student will complete educational requirements
Retained Status: * - Student was not retained at the end of the previous school year
Oct Childcount IEP Outcome: *** - No Change from latest |IEP reported to ODE
A - Active Duty - Student is a dependent of a member of the Active Duty Forces (Army, Navy, Air Force, Marine Corps,

Military Student;
fiitary studen or Coast Guard)

Fiscal Year Began 9th: 2015
CTE Program Area: Tech Prep Completer: N
CTE Program of Concentration:™ - Student is not a concentrator in any CTE Program
Majority Of Attendance IRN: R Accountability IRN: R

Report to EMIS: Yes
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Individual Student Data

EMIS Reportable Data — From FN - Graduate Tab of Profile

Studentinformation > EZ Query > EZ Students > EMIS Demographic

EMIS Demographic

From this screen users can view a student's EMIS data.

Choose data to view: FN - Graduate +

FN Attributes Detail:

CORE Economics and Financial Literacy Requirement Met: N - District has not determined this student met requirement

CORE Fine Arts Requirement Met: M - District has not determined this student met requirement

CORE Graduation Requirement Exemption: *

Exempted from Physical Education Graduation Requirement:N - District not adopted policy or student has not met all of policy re
Graduation Date:

Diploma Type: * - Mot Applicable
OGT Graduation Alternative: 0 - OGT Graduation Alternative
Military Compact Graduation Alternative: 0

EMIS Reportable Data — EMIS - Student (Not From Profile)

Studentinformation = EZ Query = EZ Students > EMIS Demographic

EMIS Demographic

From this screen users can view a student's EMIS data.

Choose data to view: EMIS - Student ~

EMIS - Student Detail:
Legal First Name:

Legal Middle Name:
Legal Last Name:
Mother's Maiden Name:

Birthplace City: MANSFIELD

Birthdate: 6/4/2001

Age: 16

Gender: M - Male

Ethnicity: W - White, Non-Hispanic

Native Language: ENG - English (Default)

Home Language: =* - Neither LEP nor Immigrant in current fiscal year-specific home lang

ProgressBook Studentinformation EZ Query Guide
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View Student’s Enroliment History

Note: EMIS enrollment data for years prior to FY09 is not available on this screen.

Note: For detailed information about student enroliment, see the ProgressBook
Studentinformation Student and Registration Guide.

Navigation: Studentinformation — EZ Query — EZ Students — Enroliment

With a student in context, the Enrollment screen displays the student’s enrollment history for all
school years for which the student was enrolled in a school or district using Studentinformation.

Studentinformation > EZ Query > EZ Students > Enroliment

Enroliment

From this screen, you can view a student's enroliment information.

Studentinformatien Enroliment

Year

2012-2013

2012-2013

2013 - 2014

2014 - 2015

2015 -2016

2016 - 2017

2017 - 2018

Regular
Regular
Regular
Regular
Regular
Regular

Regular

EMIS Enroliment

Start Withdraw Withdraw EMIS

Date Date

8/1/2016

8/1/2015

8/1/2014

8/1/2013

8/M/2012

Year Type Date

Jul 01, 2012

Jul 01, 2012

Jul 01, 2013

Jul 01, 2014

Jul01, 2015

Jul 01, 2016

Jul 01, 2017

Reason Situation

Event

District Admission
Building Admission
Building Admission
Building Admission
Building Admission
Building Admission

Building Admission

District

School

SADoc

SADoc Elemeniary School
SADot Elementary School
SADoc Elementary School
SADoc Elementary School
SADoc Elementary School

SADoc Middle School

District Of How

300430
300430
300430
300430

300430

Q| 1Q

ES12

ES13

ES14

ES15

ES16

M317

How

Relationship Residence Received Received

IRN

Only school dist atiended, inc tranfer within dist
Only school dist attended, Inc tranfer within dist
Only school dist atiended. inc tranfer within dist
Only school dist attended. inc tranfer within dist
Only school dist atiended. inc tranfer within dist

Only school dist atiended, inc

Tuition Percent Attending SentTo  Sent Sent SentTo  Sent Sent

Type Of Time  Building Reasen To To % Reason To To %
IRN 1 IRN 1 of 2 IRN2 Of
Time 1 Time 2
N 100 300431 NA 0 NA 0
N 100 300431 NA | e 0 NA e 0
N 100 300431 NA 0 NA - 0
N 100 300431 NA | e 0 NA 0
N 100 300431 NA - e 0 NA - e 0

View Student’s School Medical Records

Note: For detailed information about student medical information, see the
ProgressBook Studentinformation Student Medical Guide.

Navigation: Studentinformation — EZ Query — EZ Students — Medical

With a student in context, the Medical screen displays any information about the student’s
medical alerts, medication to be taken at school, health screening done by the school, and
immunization records.

Note: Private Notes do not display in the student Medical Alerts grid.
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Studentinformation > EZ Quel EZ Students > Medical Find Students]

Medical

Medical Alerts

Date Alert Description  Priority Starting Date Ending Date Author Life Threatening

Apr 28,2015 ALLERGY ASTHMA 5 Aug 14, 2014 ashc_vmiller
Student Medication
Date Received Requires Refrigeration Medication Dosage Doctor Comments Expiration Date
There are no records fo display
Vision Screening

Exam Date  Glasses/Contacts Eyesight PlusLenses Nearsighted/Farsighted Muscle Balance ColorBlindness Stereopsis Referral Date Comments

Sep 25, 2012 N R-30 N Near - P Near - N N
L-30 Far-P Far-

Scoliosis Screening

Exam Date  Result Code Comments
Jan 17, 2014 P

Jan 17, 2012 P
Dental Screening

Exam Date  Private Exam Mouthwash Referral Date Special Services Rendered Findings

Sep 09, 2015 ()] ™~ no cavities; redness of gums, check again in 2 months
Growth Screening

Height Weight BMI Blood Pressure Exam Date  Comments

62.0 130 | 238 110/70 Feb 10, 2014

Hearing Screening

Exam Date Left Ear Right Ear Comments

Sep 25, 2012 P P

Immunizations

Date Name Comments Waiver
Jul 07, 2011 DPT O
Apr 20, 2005 TB  TB SURVEY NOT AT RISK )]
Jul06, 2004 OPY  TB SURVEY NOT AT RISK 0
Jul 06, 2004 DPT  TB SURVEY NOT AT RISK (]
Jul06, 2004 MMR  TB SURVEY NOT AT RISK (]
Sep 26,2001 DPT  TB SURVEY NOT AT RISK (]
Apri1,2001  MMR TB SURVEY NOT AT RISK (]
Apr 11, 2001 HEP  TB SURVEY NOT AT RISK (]
Oct25,2000 OPV  TB SURVEY NOT AT RISK (]
Oct25,2000 DPT  TB SURVEY NOT AT RISK (]
Aug 23,2000 OPV  TB SURVEY NOT AT RISK (]
Aug 23,2000 DPT  TB SURVEY NOT AT RISK (]
Aug 23,2000 HEP  TB SURVEY NOT AT RISK (]
Jun 21,2000 OPY  TB SURVEY NOT AT RISK (]
Jun 21,2000 DPT  TB SURVEY NOT AT RISK (]

Jun 21,2000 HEP  TB SURVEY NOT AT RISK O

16 Records Displayed Back To Top
Physical Screening

Exam Date Referral Date Special Services Rendered Findings Pass Exam

There are no records to display
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View Student’s Memberships and Special Education Services

Note: For detailed information about student memberships, see the
ProgressBook Studentinformation Student and Registration Guide.

Navigation: Studentinformation — EZ Query — EZ Students — Membership/Service

1. With a student in context, on the Membership/Service screen, in the Select a Display
Format From List drop-down list, select the format in which you want to display
information about the student’s memberships and special education services:

*  MembershipGrid — Sorts by membership or special education service code
(ascending), then by school year (for multiple memberships with the same code).

*  MembershipGridByMembership — Sorts by membership or special education
service code (descending), then by school year (for multiple memberships with the
same code).

*  MembershipGridSchoolYearDesc — Sorts by school year (descending), then by
membership or special education service code (descending).

Note: If FY12 or earlier is in context, this screen is named Membership.

2. (Optional) If you want this screen to default to your display format selection each time, click
Set As Default.

Studentinformation > EZ Query > EZ Students > Membership/Service

Membership/Service

Select a Display Format From List:

MembershipGrid 4 Set As Default

MembershipGridByMembership
MembershipGridSchoolYearDesc
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The membership/special education information displays based on the display format you
selected as follows:

Memberships and Special Education Services —
MembershipGrid

Studentinformation = EZ Query > EZ Students = Membership/Service

Membership/Service

Select a Display Format From List:

| MembershipGrid b4 Set As Default

Membership/Service  School Year  Description

CHORUS 2012 Chorus
CHORUS 2013 Chorus
CHORUS 2014 Chorus
CHORUS 2015 Chorus
BoysBB 2016 Boy's Basketball Team
CHORUS 2016 Chorus
BoysBB 2017 Boy's Basketball Team
CHORUS 2017 Chorus

Memberships and Special Education Services —
MembershipGridByMembership

Studentinformation > EZ Query = EZ Students > Membership/Service

Membership/Service

Select a Display Format From List:

|MembershipGridByMembersnip ¥ set As Default

Membership/Service  School Year Description

CHORUS 2012 Chorus
CHORUS 2013 Chorus
CHORUS 2014 Chorus
CHORUS 2015 Chorus
CHORUS 2016 Chorus
CHORUS 2017 Chorus
BoysBB 2016 Boy's Basketball Team
BoysBB 2017 Boy's Basketball Team
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Memberships and Special Education Services —
MembershipGridSchoolYearDesc

Studentinformation = EZ Query = EZ Students > Membership/Service

Membership/Service

Select a Display Format From List:

| MembershipGridSchoolYearDesc ~ |[ESRSANSE

Membership/Service  School Year  Description

BoysBB 2017 Boy's Basketball Team
CHORUS 2017 Chorus
BoysBB 2016 Boy's Basketball Team
CHORUS 2016 Chorus
CHORUS 2015 Chorus
CHORUS 2014 Chorus
CHORUS 2013 Chorus
CHORUS 2012 Chorus

View Student’s Schedule

Note: For detailed information about student schedules, see the ProgressBook
Studentinformation Student and Registration Guide and ProgressBook
Studentinformation Scheduling Guide.

Navigation: Studentinformation — EZ Query — EZ Students — Schedule

1. With a student in context, on the Schedule screen, select the Type(s) of course section
assignments you want to view for this student and the Fields to Display in the grid.

2. Click Display.
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The student’s current course schedule displays based on the options you selected.

Studentinformation > EZ Query > EZ Students > Schedule

Schedule

From this screen, you can view a student's schedule.

[Hide Filter & Display Options]

Type:[4 Assigned [] Dropped [] Removed

Fields to Display:

[0 Group Code [] Group Name [] Group Section Course Code Course Name Course Section [] Meeting Time Desc [ Location Code [] Location Name

[] Term Code Term Name [] Assignment Status Start Date Stop Date [ Pericd Code [ Period Name Teacher

Course Course Name Crs Sec Mtg Time Teacher Term Name Start End
MAT101 PRE-ALGEBRA 1 Block 1 - RM 181 Lois Bradley All Year 08/01/2016
SCHOo1 PHYSICAL SCIENCE | 14 Block 2 - RM 185 Phyllis Harper All Year 08/01/2016
ENG101 ENGLISH 9 19 Block 3 - RM 178 Craig Snyder All Year 08/01/2016
HEA101 HEALTH 9 18 Block 4 - RM 189 Paula Carpenter All Year 08/01/2016
HIS101 WORLD HISTORY " Block 5 - RM 178 Craig Snyder All Year 08/01/2016
SP101 SPAMNISH 1 14 Block 6 - RM 187 Norma Riley All Year 08/01/2016
MUs102 CHOIR | 13 Block 7 - RM 183 Tina Andrews All Year 08/01/2016
CAR101 DECISIONS IN LIVING 18 Block 8 - RM 176 Jesse Carroll All Year 08/01/2016

Compare Student’s Home School and JVS Data

Note: Before you can view and compare data from the JVS, your school district
must set up the JVS as a trusted district. For information on this setup, see “Add
District Trusts.”

Note: Data for years prior to FYQ9 is not available on this screen.

Navigation: Studentinformation — EZ Query — EZ Students — Shared Student Data

1. With a student in context, on the Shared Student Data screen, in the Choose trusted
district and school drop-down list, select the student’s JVS district for which you want to
view data about the student.
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2.

In the Choose data to review drop-down list, select one of the following types of data that
you want to compare for the student:

Addresses and Primary Contact
Daily Absences
General/Additional

EMIS - FS

EMIS - FD

EMIS - FN

EMIS - Graduate
Schedule

Assessments

Course History

Special Education Events

Studentinformation > EZ Query = EZ Students > Shared Student Data

Choose trusted district and school: | SADoc Local Schools - SADoc HIGH SCHOOL ~

First Middle Last
JEREMIAH JACK ARLINGTON

State StudentId
KR1234567

Choose data to review: |Addre55e5 and Primary Contact v|

The data from both your school and the student’s JVS school displays for the school year
in context based on the type of data you selected to compare.
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If you select Addresses and Primary Contact, comparative residence address data displays.
You can view mailing address information or primary contact information by selecting the
appropriate option in the Address or Primary Contact drop-down list.

Studentinformation > EZ Query = EZ Students > Shared Student Data

Choose trusted district and school: | SADoc Local Schools - SADoc HIGH SCHOOL ~

First Middle Last State Student Id

JEREMIAH JACK ARLINGTON KR1234567

Choose data to review: |Addresses and Primary Contact v|

(Al:ldress or Primary Contact: | Residence Address ~ D

Data Item SADoc JVS SADoc Local Schools - SADoc HIGH SCHOOL
Address 1234 PR 123 1234 PR 123

Address 2

City MILLERSBURG MILLERSBURG

State OH OH

Zip 44654 44654

Is Unlisted No No

Home Phone 330-123-4567 330-123-4567

Email Address
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If you select Daily Absences, the Attendance Hours Summary grid displays, containing the
student’s data from the attendance calculator, and comparative absence data displays below this
grid for the period from the master calendar’s start date to today’s date. You can select a different
date range by entering or selecting different dates in the Absences From and Absences To
fields and then clicking Filter.

Note: The comparative absence data does not display period absences.

Shared Student Data — Daily Absences

Studentinformation = EZ Query = EZ Students = Shared Student Data

Choose trusted district and school: | SADoc Local Schools - SADoc HIGH SCHOOL ~

First Middle Last State Student Id
JEREMIAH JACK ARLINGTON KR1234567
Choose data to review: |Da1i|)|r Absences ~

Attendance Hours Summary

Total Excused Hours Total Unexcused Hours
ASHLAND MIDDLE SCHOOL The student has a Percent of Time (FTE) of 0 on all F5-Standing records.
ASHLAND-WEST HOLMES JVS 3724 0.28
Total Hours 37.24 0.28

(Absences From:™ |8/21/2017 B Absences To:" |9/19/2017 B )

SADoc JVS SADoc Schools - SADoc HIGH SCHOOL
Level Type Reason In Out Level Type Reason In Out
Date
Sep 08, 2017 Fyj Apsence UNEXCUSED
Sep 07, 2017 Fyj Absence UNEXCUSED
Sep 06, 2017 Fyj ppsence UNEXCUSED
Sep 05, 2017 gy Apsence UNEXCUSED
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Shared Student Data — General/Additional

Studentinformation = EZ Query > EZ Students > Shared Student Data

Choose trusted district and school:

SADoc Local Schools - SADoc HIGH SCHOOL ~

First Middle Last State Student Id
JEREMIAH JACK ARLINGTON KR1234567
Choose data to review: | General/Additional w
Data Item SADoc JVS
Student Status: INACTIVE
Overall Student Status: Inactive
Ethnicity: White
Gender: M
Citizenship:

Country of Origin:
Native Language:
Home Language:

Birth Date

Birth Date Verification Code:
Birthplace City:
Building Grade Level:
Next Grade Level:
Include In Hener Roll:
Include In Ranking:
Graduation Year:
Counselor

Program:

Home School IRN:
Home School Name:
Community Service Hours:
Report To EMIS:

Legal First Name:
Legal Middle Name:
Legal Last Name:

Legal Last Name Suffix:

English (Default)
Neither LEP nor Immigrant in current fiscal year-specific home lang

04/16/1998

MILLERSBURG
12

GR

Yes

Yes

GAVINGTON, MRS.
Satelitte Construction Trades 1
038695

SADoc High School

True
JERMIAH
JACK
ARLINGTON

SADoc Local Schools - SADoc HIGH SCHOOL
ACTIVE RES
Active
White
M

English (Default)
Neither LEP nor Immigrant in current fiscal year-specific home lang
04/16/1998

1
MILLERSBURG
12

Graduated

Yes

Yes

2017

True
JEREMIAH
JACK
ARLINGTON
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If you select EMIS - FS, comparative data about the student’s FS record displays for a particular
effective date during the school year in context. To view this comparative data for a different date
on which the student’s FS record changed, in the Effective Date drop-down list, select a different

date.

Shared Student Data — EMIS - FS

Studentinformation > EZ Query > EZ Students > Shared Student Data

Choose trusted district and school:

SADoc Local Schools - SADoc HIGH SCHOOL ~

First Middle Last State Studentid
JEREMIAH JACK ARLINGTON KR1234567
Choose data to review: | EMIS - FS ~
Effective Date: ‘0?;’01:’16 - Both Districts
Data Item SADoc JVS
Effective Start Date 07/01/2017
District Admission Date o7io2017

Admitted from IRN
District Withdraw Date
Withdrawn to IRN
Admission Reason
District Withdraw Reason
EMIS Situation

District Relationship

-

-

1 - Student transferred from home school in Ohio

SADoc Local Schools - SADoc HIGH SCHOOL

05/29/2018
05/29/2018

e

e

7 - Not newly enrolled in this school district

** - Not Applicable, Did not withdraw/was not truant ** - Not Applicable, Did not withdraw/was not truant

302 - Regular student attending JVS F/T or PIT

1 - Stud. rcvg instr. in whole/part from rep. dist

&8 - Resident attending JVS FIT

3 - Stud. not rcvg sves/instr from rep dist, must rep EMIS

How Received

Percent of Time

Attending Building IRN

District of Residence

County Of Residence

How Received IRN

Tution Type

Assigned Building IRN

Sent To 1 Reason

Sent To 1 IRN

Sent To 1 Percent of Time

Sent To 2 Reason

Sent To 2 IRN

Sent To 2 Percent of Time

Current Entity Attendance Days
Current Entity Attendance Hours
Current Entity Excused Absence Days
Current Entity Excused Absence Hours
Current Entity Unexcused Absence Days
Current Entity Unexcused Absence Hours
Other Entity Attendance Days

Other Entity Attendance Hours

Other Entity Excused Absence Days
Other Entity Excused Absence Hours
Other Entity Unexcused Absence Days

Other Entity Unexcused Absence Hours

*_ Not Applicable

100
222222 - SADOC JVS
123456 - SADoc Local SD
88 - SADoC

sxrery

N - Non-tuition student (default)

sxrery

NA - Not sent to another district
0
NA - Not sent to another district (default)
0
170.00
1062.47
5.96
3724
0.05
0.28
0.00
0.00
0.00
0.00
0.00
0.00

* - Not Applicable

0
333333 - SADoC High School
123456 - SADoc Local SD
88 - SADOC

wrmrrs

N - Non-tuition student (default)
JV - Joint Vocational School District program participant
222222 - SADoC JVS
0
NA - Not sent to another district (default)
222222 - SADoc JVS

0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
0.00
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If you select EMIS - FD, comparative data about the student’s FD record displays for a particular
effective date during the school year in context. To view this comparative data for a different date
on which the student’s FD record changed, in the Effective Date drop-down list, select a different
date.

Shared Student Data — EMIS - FD

Studentinformation > EZ Query > EZ Students > Shared Student Data

Choose trusted district and school:

SADoc Local Schools - SADoc HIGH SCHOOL ~

First Middle Last State Student Id
JEREMIAH JACK ARLINGTON KR1234567
Choose data to review: |EM|S -FD ~
Effective Date: |U?IO1I16 - Both Districts ~
Data Item SADoc JVS SADoc Local Schools - SADoc HIGH SCHOOL
Effective Start Date 07/01/2017 05/26/2018

District Withdraw Date
District Withdraw Reason
Disability Condition
Disadvantagement

Limited English Proficiency
LEP Reclass Date

Homeless Status

= - Not Applicable, Did not withdraw/was not fruant
** - Not Applicable
1 - Economic Disadvantagement

M - Mo, the student is not of Limited English Proficiency

* - Mot Applicable

= - Not Applicable, Did not withdraw/was not truant

** - Not Applicable

* - Mot Applicable

N - No, the student is not of Limited English Proficiency

* - Not Applicable

Section 504 Plan N - No N - No
Unaccompanied Youth M- MNo M- No
Migrant Status N-MNo N-No
Immigrant Status N - MNo N -No

Foreign Exchange Graduation Plan * - Not Applicable - not a foreign exchange student

Preschool Poverty Level
Reporting Calendar

Attendance Pattern

State Equivalent Grade Level

M - Mot & Preschool student
DFLT - Default

** - Not Applicable

11

* - Mot Applicable - not a foreign exchange student
M - Not a Preschool student

DFLT - Default MS

** - Not Applicable

a8
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Shared Student Data — EMIS - FN

Shared Student Data

Studentinformation > EZ Query > EZ Student

Choose trusted district and school: | SADoc Local Schools - SADoc HIGH SCHOOL ~

First Middle Last State Student Id
JEREMIAH JACK ARLINGTON KR1234567
Choose data to review: |[EMIS - FN v
Data [tem SADoc JVS

Grade Level Next Year 12 - Twelfth Grade

Oct Childcount IEP Outcome ** _No Change from latest IEP reporied to ODE
Fiscal Year Began 8th 2015

Majority Of Attendance IRN i

Military Student * - Not Applicable (Not a Military Student)
CTE Program Area

CTE Program of Concentration  ** - Student is not a concentrator in any CTE Program
Retained Status

TGRG Reading Diagnostic Result ** - Not Required

* - Student was not retained at the end of the previous school year * - Student was not retained at the end of the previous school year

SADoc Local Schools - SADoc HIGH SCHOOL
09 - Ninth Grade
=+ - No Change from latest |[EP reporied to ODE
2016
444444 - SADOC VS
* - Not Applicable (Not a Military Student)

** - Student is not a concentrator in any CTE Program

**_ Not Required

Shared Student Data — EMIS - Graduate

Studentinformation > EZ Query > EZ Students > Shared Student Data

Choose trusted district and school: | SADoc Local Schools - SADoc HIGH SCHOOL ~

CORE Economics and Financial Literacy Requirement Met

CORE Fine Arts Requirement Met

First Middle Last State Student Id
JEREMIAH JACK ARLINGTON KR1234567
Choose data to review: |EMIS - Graduale v
Data Item SADoc JVS

N - District has not determined this siudent met requirement

N - District has not determined this student met requirement

SADoc Local Schools - SADoc HIGH SCHOOL

N - District has not determined this student met requirement

N - District has not determined this student met requirement

CORE Graduation Requirement Exemption *

Diploma Date
Diploma Type *- Not Applicable
OGT Graduation Alternative 0 - OGT Graduation Alternative

Military Compact Graduation Alternative 0

Exempted From Physical Education Graduation Requirement N - District not adopted policy or student has not met all of policy re N - District not adopted policy or student has not met all of policy re

* - Not Applicable
0 - OGT Graduation Altemative
0
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If you select Schedule, comparative schedule data for the student displays. If you want to filter

the display, click Show Filter & Display Options. Then select the Type(s) of course

section

assignments you want to view for this student and the Fields to Display in the grid, and click

Display.
Shared Student Data — Schedule

Studentinformation = EZ Query > EZ Students = Shared Student Data

Choose trusted district and school: | SADoc Local Schools - SADoc HIGH SCHOOL ~

First Middle Last State Student Id
JEREMIAH JACK ARLINGTON KR1234567
Choose data to review: | Schedule -

([Show Filter & Display Options])

SADoc JVS

Course Course Name Section Meeting Time Teacher Term Name Start Stop

There are no records to display

SADoc Local Schools - SADoc HIGH SCHOOL

Course Course Name Section Meeting Time Teacher Term Name Start Stop
420  English 12 1 1 (245) Mr B Langenderfer  All Year 08/25/2016
123  Spanish | 2 2(249) Mr K Benninger All Year 08/25/2016
444 Financial Algebra 1 3 (306) Ms K Salinger All Year 08/25/2016
SH14 4 Study Hall 1 4 (253) Ms R Turner 1st Semester Only  08/25/2016
SH24 4 Study Hall 1 4 (253) Ms R Turner 2nd Semester Only 01/17/2017
Lun1  Lunch 1st sem 1 5 (XX) TO BE ANNOUNCED 1st Semester Only  08/25/2016
LunZ Lunch 2nd sem 1 9 (XxX) TO BE ANNOUNCED 2nd Semester Only 01/17/2017
333 Anatomy & Physiology Il 1 6 (188) Ms J Kingfisher All Year 08/25/2016
663  Construction Tech Lab Il 1 7.8,9 (165) Mr D Miller All Year 08/25/2016
Show Filter & Display Options
[Hide Filter & Display Options]
(e - N\
Type: Assigned [] Dropped [ Removed
Fields to Display:
Course Code Course Name Course Section Meeting Time Desc [ Location Code [] Location Name Teacher
[0 Term Code Term Name [ Assignment Status Start Date Stop Date [ Period Code [0 Period Name
J
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If you select Assessments, you can view comparative assessment score data for the student. To
view this data, in the filter and display options area, select the check box beside each assessment
score you want to view.

Studentinformation > EZ Query > EZ Students > Shared Student Data

Choose trusted district and school: | SADoc Local Schools - SADoc HIGH SCHOOL ~

First Middle Last State Student Id
JEREMIAH JACK ARLINGTON KR1234567
Choose data to review: |Assessments -

[ Hide Filter & Display Options]

All Assessments
M All Early Learning Assessments M All State Assessments

C1KRA (GO) ] DORP/NWEA Map (GD})

[] Preschool COS (GM) End of Course Exams (GE)

[] Preschool ELA (GB) [J Next Generation Grades 3-8 (GN)
[JOGT (BX)

Ohio Achievement (OAA) (GA)

M All CTE Assessments H All Non-State Assessments

[] CTE Industry Assessment (OCTCA/\VebXam [JACT (AC)

GY) [ Advanced Placement Exams (AP}
[ CTE Industry Credential (GW) [Ointernational Baccalaureate (IB)
[ WorkKeys (WK) [J OELPA (GF)

O prLAN
O psar

[[J SAT (SA) Reasoning Tests.
[J SAT Subject Tests

SADoc JVS

End of Course Exam
Test Date  Required Test Type Assessment Area Score Not Reported Accommedations Score Performance Level

There are no records to display

Student Achievement
Test Date Grade IRN Required Test Type Test Part Score Not Reported Accomm Raw Score Scaled Score Standard Passing

There are no records to display

SADoc Local Schools - SADoc HIGH SCHOOL

End of Course Exam

Test Date Required Test Type Assessment Area Score Not Reported Accommodations Score Performance Level
4/1/2018 S§TR Algebra 1 ® NO ]

4/1/2018 STR American / United States Government * NO 4

4/1/2018 S§TR English Language Arts 2 Y =

4/1/2017 STR Biology * NO 709 3

Student Achievement

Test Date Grade IRN Required Test Type Test Part Score Not Reported Accomm Raw Score Scaled Score Standard Passing

5/1/2014 07 001099 STR 07A Math * NO 150 398 Basic (]
5(1/2014 07 001099 STR 07A Reading " NO 180 395 Basic (]
5/1/2013 06 036806 STR 06A Math * NO 210 404 Proficient [T
5(1/2013 06 036806 STR 06A Reading " NO 210 408 Proficient 4
5/1/2012 05 036806 STR 05A Math * NO 160 376 Limited (]
51/2012 05 036806 STR 05A Reading " NO 220 390 Basic (]
5/1/2012 05 036806 STR 05A Science * NO 190 384 Basic (]
5172011 04 036806 STR 04A  Math " NO 200 87 Basic (]
5/1/2011 04 036806 STR 04A Reading * NO 240 402 Proficient [T
5(1/2010 03 036806 STR 03A  Math " NO 300 392 Basic (]
5/1/2010 03 036806 STR 03A Reading * NO 250 387 Basic (]
10/1/2009 03 036806 STR 03A Reading " NO 150 359 Limited (]
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If you select Course History, comparative course history data for the student displays for all

school years and credit types. If you want to filter the display, select the school year(s) and credit
type(s) to include by moving them from the associated dual listboxes on the left to the ones on the
right, select the check box beside each type of manual course record you want to view (Is High

School Credit, Include in GPA, and/or Include in Total Credits), and click Display.

Studentinformation > EZ Query > EZ Siudents > Shared Siudent Data Find stuoens]  JoRco ™

ol

Choose trusted district and school: | SADoc Local Schools - SADoc HIGH SCHOOL ~

First Middle Last State Student Id
JEREMIAH JACK ARLINGTON KR1234567
Cheose data to review: | Course History ~

[Hide Filter & Display Options]

School Years Available School Years Selected

2016-2017 ~
Include School Years: 2015-2016 P
2014-2015

2013-2014 ¥
2012-2013 v

Credit Type Available Credit Type Selected

Not Used fal
Credit Type(Home District): Progress 1

Progress 2 bl
Progress 3 Al
Progress 4 v

Credit Type Available Credit Type Selected

Not Used ~
Credit Type(Shared District): Progress 1

Progress 2 €
Progress 3 Rl
Progress 4 v

Show 'Is High School Credit' Courses Only:[] Show 'Include in GPA' Courses Only:[] Show 'Include in Total Credits' Courses Only:[]

There are no records to display

SADoc Local Schools - SADoc HIGH SCHOOL

SADoc JVS
School Term Course  Course Mark Attempted Earned Course CORE Course Is High Course Course Include in
School Year Grade Code Code Name Type Mark Credits Credits Subject Area School Credit Include in GPA | Total Credits

Course Is Course
School Term  Course Mark Attempted Earned  Course CORE High School Includein  Course Include
School Year Grade Code Code Course Name  Type Mark Credits Credits | SubjectArea Credit GPA in Total Credits
WEST HOLMES = 2015-2016 1 FIN 662 Construction Final A 3.00000 3.00000 FAR ~ (4 (4
HIGH SCHOOL Tech Lab|
WEST HOLMES  2015-2016 " INT4 662 Construction Interim A 0.00000 FAR 4 4 (4
HIGH SCHOOL Tech Lab|
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Individual Student Data

If you select Special Education Events, comparative special education event data displays for
the student. You can select a different date range by entering or selecting different dates in the
From Date and To Date fields. You can also show previous years or inactive events by
de-selecting the Show Current Year Only or Active Events check boxes, respectively. Then
click Display.

Studentinformation > EZ Query = EZ Students > Shared Student Data [Find Students] ﬂ Go To] E

Choose trusted district and school: | SADoc Local Schools - SADoc HIGH SCHOOL ~

First Middle Last State Student Id
JEREMIAH JACK ARLINGTON KR1234567
Choose data to review: | Special Education Events ~

[Hide Filter & Display Options]
From Date: 7/1/201& Show Current Year Only

To Date: 6/30/2017 Active Events

Display

SADoc HIGH SCHOOL

|IEP Test Secondary

School Event Date Date Type Start Date End Date Type Planning Outcome
SDHS Sep 12. 2016 RIEP - IEP Completion Date-Reevaluation Sep 12, 2016 Sep 11,2017 ALT TFYG IE15 - Special ed outside
regular class more than 60% of
day
SADoc JVS District - SADoc JVS
|IEP Test Secondary
School Event Date Date Type Start Date End Date Type Planning Outcome
SDJV  Sep 12, 2016 RIEP - |IEP Completion Date-Reevaluation Sep 12, 2016 Sep 11, 2017  ALT TFYG IE15 - Special ed outside
regular class more than 60% of
day

Add District Trusts
Navigation: Studentinformation — Management — District Administration — District Trusts

District trusts are relationships you set up at the district level to designate another district (such as
a JVS) as a trusted district. This type of relationship provides a read-only “window” for districts to
share data about students they have in common.

Note: The only screen where districts can view information about students in
common is the Shared Student Data screen. (See “Compare Student's Home
School and JVS Data.”)
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1. On the District Trusts screen, click Add District Trust.

Studentinformation > Management > District Administration > District Trusts

District Trusts

Add District Trust

BLRV
CHIP
DLTN
EHLM
GREN
HILL
LOPR
MAPL
NRWS
NRCN

ORVL

B &5 &8 6 8 5 5 3 8 B &
LAY A N N N A A TE T N WA

RRBD

District Code District Name a

Black River Local

Chippewa Local Schools
Dalton Local Schools

East Holmes Local Schools
Green Local Schools
Hillsdale Local Schools
Loudonville-Perrysville Ex. Village Schools
Mapleton Local Schools
Northwestern Local Schools
Norwayne Local Schools
Orrville City Schools

Reimer Road District

From this screen, you can display, add, change and delete District Trusts.

District IRN

048462

050534

050542

047688

050559

042823

045468

045831

050575

050567

044610

ooo188

Individual Student Data

Trust Type

EZ Query

EZ Query

EZ Query

EZ Query

EZ Query, Grad Points, DataMap
EZ Query, Grad Points
EZ Query

EZ Query, Grad Points
EZ Query

EZ Query

EZ Query

Grad Points

The add-edit version of the screen displays.

2. Inthe Trusted District drop-down list, select the district that you want to allow to view data
for your students in common.

3. Inthe Trust Type field, select the EZ Query check box.

Click Save. Or to continue adding district trusts, click Save and New.

Studentinformation > Management > District Administration > District Trusts

Trust Type:”

(- T

District Trusts

From this screen, you can display, add, change and delete District Trusts.

Trusted District:*| AWHC - Ashland-West Holmes JVS District

EZ Query [] Grad Points [] DataMap
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Individual Student Data

A confirmation message displays, and the district now displays in the list of district trusts.

Studentinformation > Management > District Administration > District Trusts

District Trusts
From this screen, you can display, add, change and delete District Trusts.
The District Trust was saved successfully
District Code District Name a District IRN Trust Type
@ f AWHC Ashland-West Holmes JVS District 062042 EZ Query
] & BLRV Black River Local 048462  EZ Query
i & CHP Chippewa Local Schools 050534 EZ Query
i & DLTN Dalton Local Schools 050542  EZ Query
] & EHLM East Holmes Local Schools 047688 EZ Query
] & GREN Green Local Schools 050550 EZ Query, Grad Points, DataMap
@ f HILL Hillsdale Local Schools 045823 EZ Query, Grad Points
@ y LOPR Loudonville-Perrysville Ex. Village Schools 045468 EZ Query
W & MAPL Mapleton Local Schools 045831 EZ Query, Grad Points
W & NRWS Northwestern Local Schools 050575 EZ Query
W 4 NRCN Norwayne Local Schools 050567 EZ Query
I & ORVL Orrville City Schools 044610 EZ Query
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Individual Student Data

View Student’s Fees

Note: For detailed information about student fees, see the ProgressBook
Studentinformation Fees Guide.
Navigation: Studentinformation — EZ Query — EZ Students — Student Fees

With a student in context, the Student Fees screen displays fee information for the student. If you
want to hide certain types of fees, in the Fee Options area, de-select the fees type(s).

Studentinformation > EZ Query > EZ Students > Student Fees

Student Fees

This page lists all of the student's fees that have a balance or credit due

Fee Options

Total Fees Assessed  $70.00 Show Fees from Past School
Years:
P - Payment $30.00
Show Fees from Future School
Overall Balance  $40.00 | vears:

Show Fees from All Buildings: O

Fee Type Fee Code Datew Course Section Description Amount Assessed AmountPaid Amount Owed School Code
Course Fee SHOP Aug 12, 2016 Metal Technology | Metal Techn. | $30.00 $0.00 $30.00 WHHS
Course Fee | LAB Aug 12, 2016 CP Biology Biology $10.00 $0.00 $10.00 WHHS

Total $40.00 $0.00 $40.00
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Individual Student Data

View Student’s Marks

Note: For detailed information about student current courses and marks, see the
ProgressBook Studentinformation Scheduling Guide and ProgressBook

Studentinformation Marks Guide.

Navigation: Studentinformation — EZ Query — EZ Students — Student Marks

With a student in context, the Student Marks screen displays the student’s marks for each current
course based on the finalized schedule of the school and school year in context.

You can select different course terms to display by moving them from the Course Terms dual
listbox on the left to the Selected listbox on the right and clicking View.

Studentinformation > EZ Query > EZ Students > Student Marks

Student Marks

[Hide Filter & Display Options]
Filters:
Course Terms

From this screen you can view student marks

Selecte

d

2nd Semester Only All Year
1st Semester Only = =

K 9

(e )

Term Code Name Sec  Status Cred Teach
All Year 420 English 12 1 Assigned 1.00 BLAS 1
All'Year 125  Spanish | 2 Assigned 1.00 KBEA @ 2
All'Year 444  Financial Algebra 1 Assigned 1.00 KsMml 3
All Year = 333 Anatomy & Physiology Il | 1 Assigned  1.00 JEKI 6
All Year 663 Construction Tech Labll 1 Assigned 3.00 DMCM

Per GP1 INT1 GP2 INT2 GP3 INT3 GP4 INT4 FIN
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Tools

Tools

EZ Query’s Tools screens provide a collection of classroom management resources.

Note: If you do not have access to these screens on the site map, these options
do not display. If you do, you can access all students regardless of your job
function and without using staff impersonations. For more information, see the
ProgressBook Studentinformation Security Guide.

Refer to the appropriate topic as follows:

*  “View My Class Schedule”
e “Generate Student List”

* “Maintain Seating Charts”

* “Generate Absence List”

* “View Teacher Directory”

* “View Upcoming Student Birthdays”

View My Class Schedule

Navigation: Studentinformation — EZ Query — Tools — Teacher Class Schedule

On the Teacher Class Schedule screen, you can see your own schedule or that of another
teacher by class period. Select the Teacher, Term, and at least one Day Of The Week, and click

View Schedule.

Studentinformation = EZ Query > Tools = Teacher Class Schedule

Teacher Class Schedule

Teacher| ERIC ERICSON

v| Term 1stsemony

Day Of The Week[ M - Monday [] T- Tuesday [] W -Wednesday [] R - Thursday [] F - Friday

| View Schedule |

Teacher Schedule For Day: M

Period Course

5

2

P333A

P333B

P333B

P444

P444

P355A

999

Course Name

ALGEBRA Il SEM A

ALGEBRA Il SEM B

ALGEBRA Il SEM B

COMNSUMER MATH

CONSUMER MATH

EARTH AND SPACE SCIENCE A

HEALTH

INDIVIDUAL INSTRUCTION

Section Room

51 0111
12 0111
12 0111
il 0111
51 0111
41 0111
41 0111

1 0111
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Generate Student List

Navigation: Studentinformation — EZ Query — Tools — Student List

Note: If you do not have the job function of teacher in Studentinformation security,
to use this option, you must have the permission to Allow Staff Member to view
all Students in EZ Query. For more information, see the ProgressBook

Studentinformation Security Guide.

On the Student List screen, you can view and download a list of students assigned to specific
course sections as a detailed list or picture list. Select your criteria, and click Build List.

Note: For information on running reports, see the ProgressBook

Studentinformation Getting Started Guide.

Studentinformation > EZ Query > Tools > Student List

Student List

[Hide Filter & Display Options]

From this screen users can view student lists at the school and school year in context

Assignment Filters: ® Course Section Assignment O Homeroom Assignment

| - American Indian

Display Options:

&3 File Download Options

List Type:
Sort Column: Student Name ~

Assignment Date:*|6f'1:’201? | =
Teacher:™ | [ Select Teacher ] V| [J show All Teachers
Course: [Al] ~

Section: [AIT ~

Student Filters:

Gender; [All] v

Available Grade Levels Selected
09-09

10-10 PN

11-11 PPN

12-12

Available Ethnicities Selected
A - Asian

B - Black or African American (R

H - Hispanic FPRFeY

® Detailed Information O Picture List

|Select A File Type | | Select A Download Method

Build List

41
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Tools

If you select Detailed Information, student demographic details display. To view additional
information about a student, click the student’s name.

Studentinformation > EZ Query = Tools >

Student List

[Show Filter & Display Options]
Assignment Date:6/1/2017

Teacher: ERICSON, ERIC
Sort Column: Student Name
Sort Type: Ascending

Student Name
HARRISON, TYLER

Parent: JOHN/JEANETTE HARRISON

Student List — Detailed Information

Student List

From this screen users can view student lists at the school and school year in context

Number Birthdate Gender Ethnicity

123456 01/06/1999 M White

Address: 1234 MILLER ST ASHLAND OH 44805

Grade  Status Email

12 ACTIVE RES

Phone: (123) 456-7890 (Home Phone)

Parent: JASON/CASSANDRA TURNER

Address: 3456 MAIN ST ASHLAND OH 44805

COLEMAN, CONNOR 087654 05M17/2000 M White 10 ACTIVE RES
Parent: TAMMY COLEMAN Address: 9876 CHESTNUT ST ASHLAND OH 44805 Phone: ()
SHIELDS, MADISON 234567 04/08/2002 F White 09 RES A/ELSE  FakeAddress@Software-Answers.com

Phone: (123) 987-6540 (Work Phone)

Student List — Picture List

Studentinformation > EZ Query > Tools > Student List

Student List

From this screen users can view student lists at the school and school year in context

[Show Filter & Display Options]

Assignment Date:6/1/2017
Teacher: ERICSON, ERIC
Sort Column: Student Name
Sort Type: Ascending

3 Records Found

PHOTO
AVAILABLE

NO NO
PHOTO

AVAILABLE

PHOTO
AVAILABLE

NO

TYLER HARRISON

CONNOR COLEMAN

MADISON TURNER

3 Records Found
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Maintain Seating Charts

You can maintain classroom seating charts in Studentinformation in the following ways:

* To view an existing seating chart, see “View Seating Charts.”

* To create a new seating chart, see “Create Seating Charts.”

e To assign seats to students, see “Assign Seats.”

e To edit the setup of an existing seating chart, see “Edit Seating Charts.”
e To delete a seating chart, see “Delete Seating Charts.”

View Seating Charts
Navigation: Studentinformation — EZ Query — Tools — Seating Chart
You can see classroom seating charts for your own classes or those of another teacher.

1. On the Seating Chart screen, select the Teacher and Date, and click Go.

A list of seating charts for the indicated teacher and date displays.

Studentinformation > EZ Query > Tools > Sealing Chart [Find Students] a;: To E

Seating Chart

From this screen, you can display, add, change and delete data pertaining te Seating Charts.

l Teacher:"| ERIC ERICSON ~| pate:*[0or2612016 E )

Add Seating Chart
Scheduling  Peried Rotation

Name Term - Day Location Course Sections Class Date  Active

@ ¢ INDIVIDUAL INSTRUCTION (11,15); CONSUMER MATH (11) = 08/20/2016 1 F 0111 INDIVIDUAL Sep 30,2016 @
INSTRUCTION
(11,15); CONSUMER
MATH (11)

T | & | INDIVIDUAL INSTRUCTION (15); ALGEBRA Il SEM B (12) 08/29/2016 1 M o111 INDIVIDUAL Sep 26, 2016 [ ]
INSTRUCTION
(11,15), CONSUMER
MATH (11)

[0 show Active Only
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2. Click the name of the seating chart you want to view.

Tools

[Find Students] m:;:_c:

Studentinformation > EZ Query > Tools > Seating Chart

10

Seating Chart

From this screen, you can display, add, change and delete data pertaining to Seating Charts.

Teacher:"| ERIC ERICSON ~ | Date:*|09/25/2016 =

Add Seating Chart
Scheduling Period Rotation

Name Term - Day Location Course Sections Class Date

@ & ( MDIVIDUAL INSTRUCTION (11,15); CONSUMER MATH (nD 08/29/2016 1 F 0111 INDIVIDUAL Sep 30, 2016
INSTRUCTION

(11,15); CONSUMER

MATH (11)

[ ¢ INDIVIDUAL INSTRUCTION (15); ALGEBRA Il SEM B (12) 08/29/2016 1 M 0111 | INDIVIDUAL Sep 26, 2016
INSTRUCTION
(11,15); CONSUMER
MATH (11)

[ show Active Only

Active

The selected seating chart displays.

Note: For information on assigning seats to students, see “Assign Seats.”

Studentinformation > EZ Query > Tools > Seating Chart

Seating Chart

From this screen, you can display, add, change and delete data pertaining to Seating Charts.

Name:” INDIVIDUAL INSTRUCT

NO NO
PHOTO PHOTO
AVAILABLE AVAILABLE
COLEMAN, CONNOR TURNER, MADISON

NO NO
PHOTO PHOTO
AVAILABLE AVAILABLE
JACKSON, HANNAH HARRISON, TYLER

l Cancel .
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Create Seating Charts
Navigation: Studentinformation — EZ Query — Tools — Seating Chart

You can create one or more classroom seating charts per course section for your own classes or
those of another teacher.

1. On the Seating Chart screen, select the Teacher and Date.
2. Click Add Seating Chart.

Studentinformation > EZ Query > Tools > Seating Chart [Find Stugents] __ Jalfico To) )Q,

Seating Chart

From this screen, you can display, add, change and delete data pertaining to Seating Charts.
Geacher:*‘ ERIC ERICSON uDate:*|{]gf1g;2016 &

| Add Seating Chart '
Scheduling Perieod Rotation

Name Term - Day Location Course Sections Class Date  Active

@ 4 INDIVIDUAL INSTRUCTION (11,15); CONSUMER MATH (11)  08/20/2016 1 M 0111 INDIVIDUAL Sep 26,2016 @
INSTRUCTION
(11,15); CONSUMER
MATH (11)

W &  INDIVIDUAL INSTRUCTION (15); ALGEBRA Il SEM B (12) 08/29/2016 1 M 01 INDIVIDUAL Sep 26, 2016 [ ]
INSTRUCTION
(11,15); CONSUMER
MATH (11)

Show Active Only

The add-edit version of the screen displays.

3. Inthe Period drop-down list, select a class period (course section) specific to the teacher
for whom you are creating the seating chart.

4. For the Start In Corner option, select the radio button that corresponds to the physical
corner of the room where you wish to start creating the seating chart (i.e., top left, top right,
bottom left, or bottom right).

5. (Optional) Specify a number of Columns for the seating chart.

Note: If you leave this field blank, Studentinformation calculates the number of
columns based on the number of students.

6. Inthe Pictures drop-down list, select the scaling of the student picture size (from 10% to
200% of original size).

7. To make the student pictures display on the seating chart, select the Show check box. To
hide them, de-select the check box.

8. (Optional) Select a Collision Mode to determine what should happen if you move a
student into a seat that displaces another student:

e Switch target with source — Switches the two students.
* Move target to end — Moves displaced student to the end of the seating chart.

9. Ifthe Location drop-down list is activated (i.e., not grayed out), select the course section
location.
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10. In the Render drop-down list, select how you want to arrange the student names and/or
pictures on the seating chart (Across or Up and Down).

11. In the Sort By drop-down list, select how you want to sort the student names and/or
pictures on the seating chart (Student Name Ascending, Student Name Descending,
or Random).

12. (Optional) Specify a number of Rows for the seating chart.

Note: If you leave this field blank, Studentinformation calculates the number of
rows based on the number of students.

13. Select the Perspective of the student seats:

* In Seats — Prints the front of the classroom at the top, as if you are sitting in one of the
seats.

* Facing Seats — Prints the front of the classroom at the bottom, as if you are standing
at the front of the classroom and facing the seats.

14. (Optional) If you want the seat number drop-down list to display on the seating chart, select
the Move Drop Down check box.

15. Click Generate.

Studentinformation > EZ Query > Tools > Seating Chart

Seating Chart

From this screen, you can display, add, change and delete data pertaining to Seating Charts.

[Hide Grid Options]

Period:* |— Select a Period — ~| Location:” I— Select a Period —
oo
Start In Corner: 00
sort By: | Student Name Ascending
coumns: [ ] ows: ]
Pictures: Show Perspective:
Collision Mnde:| Switch target with source -~ Move Drop Down:[]

(=

The screen expands to display more options.

16. (Optional) If you need to make any changes to the original fields you completed, make the
changes and click Update.

17. Enter a Name for this seating chart.

18. (Optional) If you do not want this seating chart to be currently active, de-select the Is
Active check box.
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19. Click Save.

Studentinformation > EZ Query = Tools » Seating Chart

Seating Chart

From this screen, you can display, add, change and delete data pertaining to Seating Charts.

[Hide Grid Options]

coumns: |5 ]
Pictures: Show

Collision Mude:| Switch target with source ~

IECH Cancel

Period:” |5—INDIVIDUAL INSTRUCTION (15)...  Location:™ |0111 -

Move Drop Down:

Name;*|lndividual Instruction

Is Active

()=

The new seating chart displays on the Seating Chart screen.

Studentinformation > EZ Query > Tools > Seating Chart

Seating Chart

[Find Students

1ol

From this screen, you can display, add, change and delete data pertaining to Seating Charts.

The Seating Chart was saved successfully

Teacher:*| ERIC ERICSON | Date:* parorzote EY <o
Add Seating Chart
Scheduling
Name Term
i & INDIVIDUAL INSTRUCTION (11,15); CONSUMER MATH (11) = 08/20/2016
il | & INDIVIDUAL INSTRUCTION (15); ALGEBRA Il SEM B (12) | 08/29/2016
] & Individual Instruction 08/29/2016

Show Active Only

Period

-

Rotation
Day Location Course Sections

M 0111 INDIVIDUAL
INSTRUCTION
(11,15); CONSUMER
MATH (11)

M 0111 INDIVIDUAL
INSTRUCTION
(11,15); CONSUMER
MATH (11)

M 0111 INDIVIDUAL
INSTRUCTION (15);
CONSUMER: MATH
(51); ALGEBRA Il
SEM A (51)

Class Date

Sep 26, 2016

Sep 26, 2016

Sep 19, 2016

Active

Note: You still need to assign seats to students. For information on this

procedure, see “Assign Seats.”

a7
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Tools
Assign Seats
Navigation: Studentinformation — EZ Query — Tools — Seating Chart

You can assign seats to students immediately after creating the seating chart (see “Create
Seating Charts.”) or at a later time if new students join your class or you want to reassign seats.

1. On the Seating Chart screen, select the Teacher and Date, and click Go.

A list of seating charts matching your criteria displays.

2. Click the name of the seating chart.

Studentinformation > EZ Query > Tools > Seating Chart Fina students) JoWeo 1 )a

Seating Chart

From this screen, you can display, add, change and delete data pertaining to Seating Charts.

Teacher:"| ERIC ERICSON | Date:*|00126/2015 2
Scheduling Period Rotation
Name Term - Day Location Course Sections Class Date Active
@ , INDIVIDUAL INSTRUCTION (11,15); CONSUMER MATH (11D 08/29/2016 1 F o1 INDIVIDUAL Sep 30, 2016 .
INSTRUCTION
(11,15); CONSUMER
MATH (11)
W & INDIVIDUAL INSTRUCTION (15). ALGEBRA Il SEM B (12) 08/29/2016 1 M o111 INDIVIDUAL Sep 26, 2016 [ ]
INSTRUCTION
(11,15); CONSUMER
MATH (11)

[0 show Active Only

The seat assignment version of the screen displays.
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3. For any student who is new or unassigned to a seat, in the associated New Student
drop-down list, select a seat number for the student.

Studentinformation > EZ Query > Tools > Seating Chart

Seating Chart

From this screen, you can display, add, change and delete data pertaining to Seating Charts.

Name:” INDIVIDUAL INSTRUCT

NO NO
PHOTO PHOTO
AVAILABLE AVAILABLE
COLEMAN, CONNOR TURNER, MADISON

NO NO
PHOTO PHOTO
AVAILABLE AVAILABLE
JACKSON, HANNAH HARRISON, TYLER

[ Cancel |
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StudentIinformation assigns the seat(s) to the student(s).

Studentinformation > EZ Query > Tools > Seating Chart

Seating Chart

From this screen, you can display, add, change and delete data pertaining to Seating Charts.

NO
PHOTO
AVAILABLE

COLEMARN, CONNOR

NO
PHOTO
AVAILABLE

JACKSON, HANNAH

l Cancel .

Name:” INDIVIDUAL INSTRUCT

NO
PHOTO
AVAILABLE

TURNER., MADISON

NO

PHOTO
AVAILABLE

HARRISON, TYLER

Tools
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Edit Seating Charts
Navigation: Studentinformation — EZ Query — Tools — Seating Chart
You can edit the setup of an existing seating chart.

1. On the Seating Chart screen, select the Teacher and Date, and click Go.

A list of seating charts matching your criteria displays.

Studentinformation > EZ Query > Tools > Seating Chart [Find Students nzc To]

Seating Chart

From this screen, you can display, add, change and delete data pertaining to Seating Charts.

l Teacher:*| ERIC ERICSON ~| pate:*[oorz62016 E )

Add Seating Chart
Scheduling Period Rotation

Name Term

INSTRUCTION
(11.,15); CONSUMER
MATH (11)

INSTRUCTION
(11,15); CONSUMER
MATH (11)

[0 show Active Only

- Day Location Course Sections Class Date  Active

[ & INDIVIDUAL INSTRUCTION (11,15), CONSUMER MATH (11) | 08/29/2016 1 F 0111 INDIVIDUAL Sep 30, 2016 [ ]

@ , INDIVIDUAL INSTRUCTION (15); ALGEBRA Il SEM B (12) 08/29/2016 1 M o111 INDIVIDUAL Sep 26, 2016 [ ]

2. In the row of the seating chart you want to edit, click &

Studentinformation > EZ Query > Tools > Seating Chart [Find Students nzc To]

Seating Chart

From this screen, you can display, add, change and delete data pertaining to Seating Charts.

Teacher:'|ERIC ERICSON ~| pate:* 091912016 ]

Add Seating Chart
Scheduling Period Rotation

Name Term - Day Location Course Sections Class Date

@ , INDIVIDUAL INSTRUCTION (11,15); CONSUMER MATH (11) = 08/29/2016 1 M o1 INDIVIDUAL

INSTRUCTION
(11,15); CONSUMER
MATH (11)

@\NDIVIDUALINSTRUCTION(15);ALGEBRAIISEMB(12) 08/20/2016 1 M 0111 INDIVIDUAL Sep26.2016 @
INSTRUCTION
(11.15); CONSUMER
MATH (1)

Sep 26,2016 @

Show Active Only

Active

The add-edit version of the screen displays.

51

ProgressBook Studentinformation EZ Query Guide



3. Make any desired changes, and click Save.

Note: For more information about the fields on this screen, see “Create Seating
Charts.”

Studentinformation > EZ Query > Tools > Seating Chart

Seating Chart

From this screen, you can display, add, change and delete data pertaining to Seating Charts.

[Hide Grid Options]
Period:* | 5 - INDIVIDUAL INSTRUCTION (15)... - Location:” |0111 v

Columns: D Rows: D
Pictures: show Perspective:

Collision Mnde:| Switch target with source ~ Move Drop Down:
Update eSS
Name:*|lndividua| Instruction Is Active

Delete Seating Charts
Navigation: Studentinformation — EZ Query — Tools — Seating Chart

1. On the Seating Chart screen, select the Teacher and Date, and click Go.

A list of seating charts matching your criteria displays.

Tools

Studentinformation > EZ Query > Tools > Seating Chart [Find Studenis) Jo¥fco o)

Seating Chart

From this screen, you can display, add, change and delete data pertaining to Seating Charts.

l Teacher:*| ERIC ERICSON ~ | Date:* 09iz6/2016 |e )

Add Seating Chart

Scheduling Period Rotation

Name Term FS Day Location Course Sections Class Date Active

@ l INDIVIDUAL INSTRUCTION (11,15); CONSUMER MATH (11) | 08/29/2016 1 F 0111 INDIVIDUAL Sep 30, 2016 [ ]
INSTRUCTION
(11,15); CONSUMER.
MATH (11)

@ l INDIVIDUAL INSTRUCTION (13); ALGEBRA Il SEM B (12) 08/29/2016 1 M 0111 INDIVIDUAL Sep 26, 2016 [ ]
INSTRUCTION
(11,15); CONSUMER
MATH (11)

[J show Active Only
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2. Inthe row of the seating chart you want to delete, click [}

Studentinformation > EZ Query > Tools > Seating Chart

Seating Chart

From this screen, you can display, add, change and delete data pertaining to Seating Charts.

[Find Students] ch To) I..I

Teacher:| ERIC ERICSON | Date:* parorzote E

Add Seating Chart
Scheduling Period Rotation

Name Term - Day Location Course Sections Class Date  Active

Wil | #*  INDIVIDUAL INSTRUCTION (11,15); CONSUMER MATH (11) = 08/20/2016 1 M 0111 INDIVIDUAL Sep26,2016 @
INSTRUCTION
(11.,15); CONSUMER
MATH (11)

j INDIVIDUAL INSTRUCTION (15); ALGEBRA Il SEM B (12) 08/29/2016 1 M 0111 | INDIVIDUAL Sep 26,2016 @
INSTRUCTION
(11,15); CONSUMER
MATH (11)

Show Active Only

A message displays, asking if you are sure you want to delete the seating chart.
3. Click OK.

Studentinformation > EZ Query = Tools > Seating Chart

Seating Chart

From this screen, you can display, add, change and delete data pertaining to Seating Charts.

Are you sure you want to deactivate the following Seating Chart?

INDIVIDUAL INSTRUCTION (13); ALGEBRA Il SEM B (12)

Studentinformation > EZ Query > Tools > Sealing Chart [Go To] E

Seating Chart

From this screen, you can display, add, change and delete data pertaining te Seating Charts.

The selected Seating Chart was successfully deleted x

Teacher:"| ERIC ERICSON ~| Date:*0911972016 B

Add Seating Chart
Scheduling Period Rotation

Name Term - Day Location Course Sections Class Date  Active

W 4 INDVIDUAL INSTRUCTION (11,15); CONSUMER MATH (11) | 08/29/2016 1 M 0111 INDIVIDUAL Sep 26, 2016 [ ]
INSTRUCTION (11,15);
CONSUMER MATH (11)

Show Active Only
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Generate Absence List

Navigation: Studentinformation — EZ Query — Tools — Absence List

On the Absence List screen, you can view and download a list of all student absences by date
for the school in context. Select your criteria and click View.

Note: For information on running reports, see the ProgressBook
Studentinformation Getting Started Guide.

Note: The Absence Reason, Absence Note, and Absence Comments column
options do not display if your school, district, or ITC has chosen to make them
unavailable. For more information, see the ProgressBook Studentinformation
School Year Setup and Configuration Guide.
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Absence List — Select Criteria

> EZ Query > Tools > Absence List

Absence List

From this screen users can view student lists at the school and school year in context

[Hide Filter & Display Options]
Absence Filters:

[J show All Teachers

[J show All Homerooms

School: SADoc High School
Absence Date:” |09/15/2017 5]
Absence Type Selected
EXCUSED ~
TRUANT =
NOT ABSENT e
DISC CTR v
Collection Periods Selected
Administrative Homeroom
=
e
Student Filters:
Teachers Selected
Adams, Edward ~
Alexander, Ryan e =
Allen, Betty PPN
Alvarez, Rodney v
Homerooms Selected
Alexander_Ryan (RM 96) ~
Boyd_Brandon (RM 134) = =
Bryant_Ann (RM 95) PPN
Butler_Catherine (RM 91) v
Counselors Selected
=
e

[0 show All Counselors

Display Options:
Columns to Display:

[J student Home School IRN [] Student Home School Name Student Grade Level Student Name

Student Calendar [0 student Homeroom [0 student Counselor

Absence Level Absence Time In Absence Time OQut Absence AMPM
[J] Absence Date [0 Absence Collection Period Absence Type Absence Reason
Absence Note Absence Comments

&3 File Download Options

|select A File Type | |Select A Downioad Method ~

View
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Absence List

Studentinformation > EZ Query = Tools = Absence List

Absence List
From this screen users can view student lists at the school and school year in context

[Show Filter & Display Options]

Absence Date: 10/M17/2016

Absence Type: EXCUSED, TRUANT
Collection Periods:Administrative Homeroom

Homerooms: 0-111 (0111),0-222 (0222),0-333 (0333),0-444 (0444)
Grade Student Name Cal. Level Type Reason Note In
09 BARRINGTON, MEGAN DFLT Full EXCUSED
Absence
08 DASHING, AUBREY DFLT  Full EXCUSED
Absence
09 DARKLAW, CHARLENE DFLT = Full EXCUSED
Absence
09 FRANK, ABIGAIL DFLT  PM EXCUSED
Absence

Out

09:02
AM

12:50
AM

AM/PM Comments

PM

Tools

View Teacher Directory

On the Teacher Directory screen, you can look up contact information for a specific teacher by

selecting the Teacher and clicking Lookup Teacher.

Studentinformation > EZ Query > Tools > Teacher Directory

Teacher Directory

Geache Edward Adams ~| KGR |

Edward Adams

8036 Mill Ave
SADoc, OH 44320-0000
(123) 456-7890
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View Upcoming Student Birthdays

Navigation: Studentinformation — EZ Query — Tools — Upcoming Birthdays

Note: If you do not have the job function of teacher in Studentinformation security,
to use this option, you must have the permission to Allow Staff Member to view
all Students in EZ Query. For more information, see the ProgressBook
Studentinformation Security Guide.

You can view upcoming student birthdays by school in both list and calendar formats. See the
appropriate topic as follows:

“View Birthday List”
“View Birthday Calendar”

View Birthday List

1.

On the Upcoming Birthdays screen, in the drop-down list, select the school for which you
want to view student birthdays.

Select the List format.
Click Submit.

Studentinformation > EZ Query = Tools > Upcoming Birthdays

Upcoming Birthdays

7

(| sADoc High school ~|® List O Calendarm
M

The screen displays a list of all birthdays of active students coming up in the next week.

(Optional) To change the date range of birthdays in the list, in the Birthdate Date Range
fields, enter or select a beginning and ending date, and click Refresh.

Studentinformation > EZ Query > Tools > Upcoming Birthdays

Upcoming Birthdays
|SADoc Hign School ~|@ List O calenuar
Gmhuate Date Range:*[9/19/2017 |8 to" [or6r2017 = )

First Name LastName Birthday o Birthdate Age onBirthday Grade Homeroom Homeroom Teacher School

Marston Weber 9/20/2017 08/20/2000 17 12 DOHS102 Ford, Juan DOHS
Layne Carlson 9/20/2017 08/20/2002 15 10 DOHS
Issac Stanley 9/21/2017 08/21/2002 15 10 DOHS
Arpad Adkins 92242017 09/22/2000 17 12 DOHS107 Woods, Teresa DOHS
Wyoming Sherman 9/23/2017  09/23/2000 17 12 DOHS132 Crawford, Bruce DOHS
Albion Franklin 9/26/2017 09/26/2002 15 10 DOHS
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The screen refreshes to display the upcoming birthdays for the selected date range.

Studentinformation > EZ Query > Tools > Upcoming Birthdays

Upcoming Birthdays
[sADoc g scvom

List O Calendar

Birthdate Date Range:*|gf191201 7

|8 10" |oozer2017

-z

First Name LastName Birthday o Birthdate

Marston Weber 9/20/2017  09/20/2000
Layne Carlson 9/20/2017 | 09/20/2002
Issac Stanley 9/21/2017 09/21/2002
Arpad Adkins 9/22/2017 09/22/2000

Wyoming Sherman 9/23/2017  09/23/2000

Albion Franklin 9/26/2017  09/26/2002
Cathryn Bates 9/27/2017  09/27/2002
Winema Harvey Q/27/2017  09/27/2002
Gabriel Lawson 9/28/2017  09/28/2002
Fitzgerald Smith 9/29/2017  09/29/2000
Salvador Neal 9/29/2017  09/29/2002

Age on Birthday Grade

17

15

15

17

17

15

13

15

13

17

19

12

10

10

12

12

10

10

10

10

12

10

DOHS102

DOHS107

DOHS132

DOHS100

DOHS105

DOHS99

Homeroom Homeroom Teacher

Ford, Juan

Woods, Teresa

Crawford, Bruce

Hayes. Joe

Sullivan, Heather

Diaz, Diane

School

DOHS

DOHS

DOHS

DOHS

DOHS

DOHS

DOHS

DOHS

DOHS

DOHS

DOHS

View Birthday Calendar

Tools

1. Onthe Upcoming Birthdays screen, in the drop-down list, select the school for which you

want to view student birthdays.
Select the Calendar format.
Click Submit.

Studentinformation = EZ Query > Tools > Upcoming Birthdays

Upcoming Birthdays

7
|| saDoc High school +|O List @ Calendarm
o

The screen displays a calendar showing birthdays of all active students for the current

month.
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4. (Optional) To display the previous or next month’s birthday calendar, click & or =,
respectively.

Studentinformation > EZ Query > Tools > Upcoming Birthdays

Upcoming Birthdays

|SADoc High School v|O List @ Calendar

(D September 2017 G)
Sun Mon Tue Wed Thu Fri Sat
27 28 29 30 21 1 2
Laila Mcbride ssac Paul
3 4 5 6|A.;a 7 8 9
Milo Santiago |gor Williamson nte Rowe Wendy Pope
Lillie Garrett
10 1 12 13 14 15 16
Alfie Ruiz Caelyn Barrett Flynn Smith Larissa Brady
Wanda Oliver Satchel
Holland
17| 18 19| 20‘ 21 22 23|
Isaiah Colon  [Finlay Smith Marston Issac Stanley Arpad Adkins Wyoming
Weber Sherman
Layne Carlson
24 25 27 28 29 30
Wlbion Franklin/Cathryn Bates (Gabriel Fitzgerald
Winema Lawson 'Smith
Harvey Salvador Neal
1 2| 3| 4 5| B 7
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The screen refreshes to display the birthdays for the selected month.

Studentinformation > EZ Query > Tools > Upcoming Birthdays

Upcoming Birthdays

|SADoc High School v|O List ® calendar

< October 2017 »|
sun Mon Tue Wed Thu Fri sat
24 25] 26| 27] 28 29| 30|
1 2| 3 4 5 g 7
\vor Briggs  |Fitz Smith LeAnn Soto  [srael Burke

Malcom Baldwin

8 9 10 1 12 13 14
Winnie Garret Winona Welch |Giles Banks Slevin Lucas
Christensen Guerrero Christian Hardy Farley Smith
15 186 17| 18 19 20 21
Flip Smith Lakeesha Ivan Fleming
Sutton
Marmaduke
Moss
22 23 24 25 26 27 28
Wyoming Gram Alvarado Willianne Gerald George
Holloway Maximillian Pearson
Stone Corbin Walsh
29 30 31 1 2| 3 4
'Sharon Haynes

Ferris Smith
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Reports

EZ Query reports provide multiple ways to display and download student data. For information on
running reports, see the ProgressBook Studentinformation Getting Started Guide.

Note: If you do not have access to these screens on the site map, these options
do not display. If you do, you can access all students regardless of your job
function and without using staff impersonations. For more information, see the
ProgressBook Studentinformation Security Guide.

Refer to the appropriate topic as follows:
e “Absence Graph”
* “Download Class List”
* “Download Student Address”
e “Download Student Medical History”
* “Medicaid Eligibility Rate (MER) Download”
e “SIS Student Search”
e “Student Membership/Services Search”
e ‘“List of Students Without Disciplinary Incidents”
*  “Weekday Attendance Percentage”

Absence Graph

Navigation: Studentinformation — EZ Query — Reports — Absence Graph
You can view absences or tardies for the current school year in graph or list format.

1. Onthe Absence Graph screen, in the drop-down list, select the school for which you want
to view absences or tardies.

2. (Optional) Select a Grade and/or Gender to filter results by those criteria.

3. Forthe Absence Type option, select whether to display Absent or Tardy records.
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Reports
4. Select how you want to view the absence or tardy data as follows:

Display Graph — Displays in graphical format.
Display Data — Displays in list format.

Studentinformation > EZ Query > Reports > Absence Graph

Absence Graph

| Al Buildings

~| Grade|
Absence Type: ® Absent O Tardy

v| Gender |

‘ Display Graph H Display Data ‘

If you click Display Graph, the absence or tardy data from the beginning of the school year
until the current date displays in graphical format using the following data points:

¢ Headcount — Total number of active status students.
ADM - Average daily membership.

Total Absent Type — Total number of absences or tardies
Percent Present — Percent of students present.

Studentinformation > EZ Query = Reports > Absence Graph

Absence Graph

HGH SCHOOL | Grade[10-10 | Gender| |

Absence Type: @ Absent

O Tardy

‘ Display Graph H Display Data ‘

Headcount

200 4

100 1

o e food g '

el

- 60

L 40

Percent Present

@ Headcount

@ Total Absent Type Percent Present
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If you click Display Data, the absence or tardy data from the beginning of the school year
until the current date displays in list format by date using the following data points:

» Date — Date of the school day for which absence or tardy data is reported.
* Head Count — Total number of active status students.

e ADM - Average daily membership.

* Total — Total number of absences or tardies.

* Average — Average attendance.

Note: Averages for the entire date range display at the bottom of the list.

Studentinformation > EZ Query > Reports > Absence Graph

Absence Graph
| HIGH SCHOOL | Grade[10-10 | Genue

Absence Type: @ Absent O Tardy

‘ Display Graph ‘ ‘ Display Data ‘

Date Head Count ADM Total Average
Sep 04, 2017 277 0.0 0.0 0.0
Sep 01,2017 277 2730 00 100.0
Aug 29, 2017 276 2720 6.0 a7.8
Sep 10, 2017 277 0.0 0.0 0.0
Sep 07, 2017 277 2730 00 100.0
Sep 13, 2017 277 2730 00 100.0
Aug 30, 2017 276 2720 65 a7.6
Sep 02, 2017 277 0.0 0.0 0.0
Sep 08, 2017 277 2730 00 100.0
Sep 05, 2017 277 2730 00 100.0

Download Class List

Navigation: Studentinformation — EZ Query — Download Class List

Note: If you do not have the job function of teacher in Studentinformation security,
to use this option, you must have the permission to Allow Staff Member to view
all Students in EZ Query. For more information, see the ProgressBook
Studentinformation Security Guide.
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This report displays a list of the school’s students and their schedules that you can further process

and include in other applications.

A A B C D E F G H I J K L M N

1 |SchoolCode Studentld StateStudentld FirstName LastName Gender GradelevelCode HomeSchoollRN HomeSchool ProgramCode ProgramName Status StudentStatusCode CourseCode
2 [AsHs 6.8E+08 Max Able M 11 ACTIVERES A 39
3 [ASHs 6.3E+08 Max Able M 11 ACTIVERES A 62
4 |ASHS 696244 GC5806968 HUGH ANDREWS M 12 9 Cognitively Delayed RES A/ELSE R 00038

5 |ASHS 493047 QV8854511 ROSE BALL F 9 ACTIVERES A 0003A

& [ASHS 790340 GB9IS10212 ALBERTO SALAZAR M 12 NON-RES N 39
A o P Q R s T u v w X

1 |CourseName CourseTypeCode CourseTypeDescription SectionMNumber TermCode TermMame LocationEx TeacherCode CalendarPeriodCode RotationDays
2 |ENGLISH 9 C Class 1 ALYR All Year 124 HALH 1 M|T|W|R|F
3 | CONCERNS OF MOD SOCIETY C Class 21 1SEM 1st Sem Only 120 HBDS 2 M|T|WIR|F
4 [ENGLISH Il C Class 21 1SEM 1st Sem Only 300 HSMG 2 M|T|W|R|F
5 |ENGLISH Il C Class 12 1SEM 1st Sem Only 300 HSMG 1 M|T|W|R|F
6 |ENGLISH 9 c Class 1 ALYR All Year 124 HALH 1 M|T|WIR|F

Note: The State Student ID only appears in the output file if you have the proper
security in Extra System Permissions — EMIS — View/Update State Student ID.
For more information, see the ProgressBook Studentinformation Security Guide.

Download Student Address

Navigation: Studentinformation — EZ Query — Reports — Download Student Address

This report displays a list of students and their addresses that you can further process and include
in other applications. You can download all contact addresses for each student or just the primary

address.
Download Student Address — All Addresses

A [ B8 [ ¢ o] E F [ 6 [u] ] J [k Jefm[n] 5] [ P [ Q |
School SSN Studen_Sta StudentName AddressLine City _State Postal TelephoneT IsUnliste Gra IsPri Add AddressTypeNam ContactName TelephoneN
DAEL  B87B75680 70°A BROWN, JOLENE JANEA 545 5 METCALF Lina OH 45805 Home Phone  FALSE KG  Yes 0 PRIMARY BROWN, HEMRY 4192287292
DAEL 897600546 14002 A ROBERTS, JEMNIFER LYNNE 742 FENCE ROWY LANE  LIMA OH 45801 FALSE 2 Yes 0 PRIMARY ROBERTS, M/N/
DAEL 908655873 12003 A  NOTT, ALAN ROBERT 7170 GREEMLAWYN Lina OH 45804 FALSE 4 Yes 0 PRIMARY MNOTT, ALVIN
DAHE 99898507 7002 A PERRY, RICHARD MATTHE (RICH) Home Phone  FALSE 9 No 23 DENTIST STREET 9873874629
DAHS 99898807 7002 A PERRY, RICHARD MATTHE (RICH) Horne Phone  FALSE 2 No 23 F1 AREQPOSTALE 2455266145
DAHS 99898907 7002 A PERRY, RICHARD MATTHE (RICH) Horne Phone  FALSE 9 No 23 ORTHODONTIST  HELPS 2453254548
DAHE 99898507 7002 A PERRY, RICHARD MATTHE (RICH) 584376 GREEN DR, Lina OH 45805 FALSE 9 No 23 ONE PARENT PERRY, DAN
DAHS 99898807 7002 A PERRY, RICHARD MATTHE (RICH) 775 BROADWAY BLVD Libda OH 45801 FALSE 2 Yes 0 PRIMARY PERRY, MATTHEW
DAHS 123098654 4005 A WWELLS, JOBETH Haorre Phone  FALSE 12 No 23 DOCTOR WWEIRD 4253560872
DAHE 123098854 4005 A WELLS, JOBETH Home Phone  FALSE 12 No 23 ORTHODONTIST  LASER 4652565487
DAHS 123098654 4005 A WWELLS, JOBETH 375786 CUTE DR LANSING M 39947 FALSE 12 No 23 OME PARENT WWELL, ELIZABETH
DAHS 123098654 4005 A WWELLS, JOBETH 843 NORTHWALD DR Lina QH 45801 FALSE 12 Yes 0 PRIMARY WYELLS, MITCH
DAHE 123854123 122445 A EVE, PRIWA 123 SECRET AVE Lina OH 45804 Home Phone  FALSE 11 Yes 0 PRIMARY EYE, BLU 4192228888
DAHS 123768453  GO05 A MAY, DAISY LEE Horne Phone  FALSE 10 Mo 23 F1 SEARS 35985746324
DAHS 123768453 6005 A MAY, DAISY LEE 49577 MALL ST, Lina QH 45805 FALSE 10 No 23 ONE PARENT MAY, JOHN
DAHS 123768453 BO0S A MAY, DAISY LEE 600 BLOOM DRIVE LinaA OH 45801 FALSE 10 Yes 0 PRIMARY LEE, SHARON
DAHS 134876456 7005 A WILLIAMSON, RYAN SETH Horne Phone  FALSE 2 No 23 DOCTOR WEIRD 3252690864

Download Student Address — Primary Address Only

A | B | ¢ [of E | F e | H [ 1 | J | kK JLlm[n] o P | o
Schoo SSN Studen St StudentName AddressLine City State Postal TelephoneT IsUnliste Gr IsPri Add Address ContactName Telephone
DAEL 498098762 1007 A BREWER, SEAN CONORY 200 E KIBBY STREET Liki& OH 45804 Home Phone  FALSE 1 Yes 0 Primary  BROWYN, MARY 4192256546
DAEL 753424 14001 A LAWSON, SHERRI ROSE 412 LAKESIDE DR LiA OH 45801 FALSE 2 Yes 0 Primary  LAWSON, KEWVIN
DAEL 7R3241867 12002 A MNELSON, AMBER MICOLE 7158 KINGSWOOD Lit& OH 45804 FALSE 4 Yes 0 Primary NELSON, ADRIAN
DAEL 7EBEE7477 13005 A WHITE, ANTHONY JAMES 217 CIRCULAR Lik& OH 45804 FALSE 3 Yes 0 Primary  WHITE, CHRISTOPHER
DAHS 458769300 4003 A JOHNSON, GEORGE EVAN 597 STATE STREET Lik& OH 45801 FALSE 12 Yes 0 Primary  JOHNSOMN, HOWARD
DAHS 689098456 6001 A EYE, CORY ROBERT 12 NORTH 5T Lik& OH 45801 FALSE 10 Yes 0 Primary EYE, EDWYARD
DAHS 555444334 7003 A RING, NMICOLE SUZANNE 9065 BLISS RD LitA OH 45801 FALSE 9 Yes 0 Primary  RING, NICHOLAS
DAHS 678956677 1224 A LEE, HARPER (LEE) 23 MOCKINGEBIRD LANE LA OH 45804 Home Phone  FALSE 9 Yes 0 Primary  FINCH, ATTICUS 4193452345
DAHS 369852368 7001 A CONTRARY, JASON WILLIAM 90 ELM STREET LiA OH 45801 FALSE 9 Yes 0 Primary  CONTRARY, MARION
DAHS 453123783 5004 A SPRAT, JACK JOSEPH 890 BACON TRAIL Lik& OH 45801 Home Phone  FALSE 9 Yes 0 Primary  TREECE, JOLENE 4192287417
DAHS 278654738 G002 A FONT, MICHELLE LYRNN 345 N FRONT 5T Lik& OH 45801 FALSE 10 Yes 0 Primary  FONT, JANE
DAHS 267874612 4001 A EYE, MAGNUM P 122 NORTH STPO Box 678 LIMA OH 45801 Home Phone  FALSE 12 Yes 0 Primary EYE, EDWARD 4195551234
DAHS 908987876 6004 A LINE, TROY AARCN B65 SUGAR STREET LikdA OH 45801 FALSE 10 Yes 0 Primary LINE, BOB
DAHS 376073245 5001 A CONTRARY, MARY M 90 ELM STREET LitA OH 45801 Home Phone  FALSE 11 Yes 0 Primary  CONTRARY, MARION 4192287417
DAHS 564789874 5002 A PERRY, MICHAEL JAY 776 BROADWAY BLYD LitA OH 45801 FALSE 11 Yes 0 Primary  PERRY, MATTHEW
DAHS 93823907 7002 A PERRY, RICHARD MATTHE (RICH) 775 BROADWAY BLWD  LIMA OH 45801 FALSE 9 Yes 0 Primary PERRY, MATTHEW
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Download Student Medical History

For information on this report, see the ProgressBook Studentinformation Student Medical Guide.

Medicaid Eligibility Rate (MER) Download

Navigation: Studentinformation — EZ Query — Reports — Medicaid Eligibility Rate (MER)

Download

You can use this download to collect and report Medicaid eligibility information from the previous
school year. This report creates a file that includes all students eligible for Medicaid who were
enrolled at some point during reporting week of the school year in context.

1. Select the correct school to put it in context.

2. Select the correct year to be in context. This should be the year designated by your
third-party billing agent.

3. On the Medicaid Eligibility Rate (MER) Download screen, in the drop-down list, select
the school district, and click Create Download File.

Studentinformation > EZ Query > Reports > Medicaid Eligibility Rate (MER) Download

Medicaid Eligibility Rate (MER) Download

QASHC - Ashland City Schools ~ [SeE=iERall b=l gl )

Studentinformation generates a fixed length export file using spaces for padding. The file
includes the following fields (with starting position and length indicated in parentheses):

Student First Name (1, 20)

Student Last Name (21, 30)

Student Residence Zip Code (51, 5)

Student Birth Date (56, 8) — in mmddyyyy format
District IRN (64, 6)

Special Education Eligibility (70, 1) —in Y/N format
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BETTY
TIM
TARA
BRADLEY
ALBERTO
DANNY
HERBERT
TROY
THELMA
DORIS
ALLEN
DAVID
JOSE
JEREMY
WILLIE
SHANE
RUSSELL
TODD
MATHEW
KATIE
KRISTEN
JEANETTE
SALVADOR
RONMNIE
KRISTINA
KAaY
JORGE
PAULINE
NORMAN
JUAN

FLYNM
RICHARDSOMN
SLATER
MCFARLAND
FOSTER
SALAZAR
MCFARLAND
FERGUSON
ROMAN
FINLEY
FLYNM
ASHLEY
BERG
HOLLOWAY
WOODARD
ALEXANDER
PATRICK
ROBERSON
PETERS
CANMON
CANMON
MARKS
STEVENS
MCKNIGHT
MORRISON
WALL
PRICE
BRADFORD
FLYNM
BAILEY

4461888182885850542Y
4461805292006850542Y
44618861420806850542N
4461806832885850542N
4461882152886850542N
4461806142067a50542N
4461882022087850542N
4461887232885850542N
4461885122886850542N
4461811172065850542Y
4468685832085850542Y
4461882232886850542N
4461885192885850542Y
4461803052008850542N
44618851320886850542N
4461882232886850542N
4461811612885850542N
4461803122006850542N
446188408520886850542N
4466785172886850542N
4461887152885850542N
4461804262006850542N
4461885842885850542N
4461885212886850542N
4463611292885850542N
446086111120865850542N
4461883242006850542N
4468689242885850542N
4461886172885850542N
4461803202006850542Y

SIS Student Search

Navigation: Studentinformation — EZ Query — Reports — SIS Student Search

Note: If you do not have the job function of teacher in Studentinformation security,
to use this option, you must have the permission to Allow Staff Member to view

all Students in EZ Query. For more information, see the ProgressBook
StudentIinformation Security Guide.

Reports

On the SIS Student Search screen, you can search for students using a variety of filter criteria
and then download the results with numerous output field options. You can also configure and
save search parameter sets so that it is easy to run the same search on a regular basis. This
screen is available at both the district level and the building level.

Note: Studentinformation uses the current date as the effective date when
searching EMIS records. Before the school year begins, it uses the maximum
calendar master start date; after the school year ends, it uses the minimum

calendar master stop date.

1. (Optional) If you have previously saved a parameter set, at the bottom of the screen in the
drop-down list, select the name of the parameter set you wish to run and then click Apply.

| Search1

=a
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Your saved selections display on each applicable tab and you can proceed to the
Summary tab to run the search.

2. If you do not have a search saved, select your search criteria as you tab through each of
the options and subtabs.

Studentinformation = EZ Query = Reports > SIS Student Search

SIS Student Search

Select Schools Filter Criteria Field Selection Summary
Schools
ASHS - ASHLAND HIGH SCHOOL "
ASJIH - ASHLAND MIDDLE SCHOOL M= =
ASED - Edison Elementary PP
ASRE - Reagan Elementary v

‘Nexlr‘

Following are important notes regarding the SIS Student Search options.

* Filter Criteria tab’s Ad Hoc subtab — If you select an ad-hoc membership as part of
your search criteria, Studentinformation ignores all other filters on all other subtabs.

e Filter Criteria tab’s Students subtab:

* To enter only part of the name in any of the name fields, enter the first couple
letters followed by %. (For example, to see all names starting with “Sa,” enter
sa%.)

e Enter Student Numbers, Social Security Number, and EMIS ID separated by
commas.

e Filter Criteria tab’s EMIS subtab — Enter SSID, District of Residence IRN, Sent To
IRN, How Received IRN, Attending Building IRN, Admitted From IRN, and
Withdrawn to IRN separated by commas.

* Field Selection tab’s EMIS subtab — The State Student ID (SSID) and
Free/Reduced Lunch Status check boxes display only if you have the proper
security permissions. (For more information, see the ProgressBook
Studentinformation Security Guide.)

3. (Optional) Once you have selected all your choices, you can name and save the set of

parameters to use in later searches by clicking . and then Create.

‘ 4 Previous [ Save

i Delete

‘ - |
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Enter a name for your parameter set and then click Save. You can now apply this
parameter set and its selections when you wish to run it (see step 1).

| Search (WEEVEN ) Cancel

Note: The parameter sets you save are visible only to you.

4. On the Summary tab, review the summary of your selection criteria.

5. Select your file download options and click Finish.

Studentinformation = EZ Query > Reports > SIS Student Search

SIS Student Search

Select School Filter Criteria Field Selection Summary

@ Click Finish To Begin The Download.

Ad-hoc Membership:OPEN ENROLLMENT
Homeroom Date: 9/15/2017
Enroliment Date: 9/M15/2017

Effective Date: 9/M15/2017
Student Alert Date: 9/15/2017
Fields: Gender, Homeroom

&3 File Download Options

|csv v| | pownioad v

=
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The output file returns the students and fields matching your selection criteria.

A A B C D E
1 |FirstName MiddleMame LastName StudentNumber Homeroom
2 |Max Able 680073371 4-103
3 |BILLIE ALEXANDER 450203

4 | DARRYL ALEXAMNDER 390281

5 |ERIK ALEXANDER 490316 6-127
6 |Holmvik Anders 154063 5-106
7 |DORA AMNDREWS 696429

8 |Guy ANDREWS 696283 4-202
9 |HUGH ANDREWS 696244 3-206
10 | MARLEME AMNDREWS 590242

11 |mMax ANDREWS 150470

12 |1ay AVERY 280016

13 | JOHNNY AVERY 1950436

14 |KELLY AVERY 490246 5-105
15 |MIGUEL AVERY 270016

16 |SANDRA AVERY 196066 6-145
17 |Dalsy AYALA 149045 4-103
18 |auce BALL 790489 6-145
19 | CHERYL BALL 268294 6-135E
20 |cLYDE BALL 159024 5-208
21 |ousTIN BALL 390250

22 | JUDITH BALL 159015 5-213
23 |JuuEe BALL 390262 6-143
24 |KATHERINE BALL 595049

25 |LEwIs BALL 495044 5-132
26 | MAURICE BALL 496057 6-156
27 |ROSE BALL 493047

28 | AARON BALLARD 696448

29 | DANNY BALLARD 592052

30 |PHILLIP BALLARD 280001 6-124

Student Membership/Services Search
Navigation: Studentinformation — EZ Query — Reports — Student Membership/Services
Search

You can search for specific memberships and services and the students who are associated with
them.
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On the Student Membership/Services Search screen, select your criteria, and click View List.

Note: The Special Education Services dual listbox only displays if FY13 or later
is in context. For prior years, you enter special education services on the Edit
Student Memberships screen and select them for this report in the Membership

Code dual listbox.

Studentinformation > EZ Query > Reports > Student Membership/Services Search

Student Membership/Services Search

List of Student Memberships

school | ASHLAND HIGH SCHOOL |

School Year 2016-2017 v

Date Range |08125/2016 B8 to |0531/2017 =
Grade

09-09 ~

10-10 e

11-1 PPN

12-12 o

Membership Group

50 - 50 )
test - test = =
11 - Intervention PPN
12 - Post-secondary Enrollment Options Program v

Membership Code

Extended Learning Time (Each Week) ~
Guided Reading (Small Group Instruction) e
Increase Reading Time: >
Interactive Writing v

Special Education Services will not be used to filter results for school
Special Education Services

years prior to FY13.

215001 - Adapted Physical Education Services )
215002 - Aide Services = =
215003 - Attendant Services PPN
215004 - Audiological Services v

Wiew List )

A list of memberships/services and associated students displays at the bottom of the

screen.
Membership Membership Membership School Student Given School
Group Code a Name Code ID Last Name Name Grade Year Term
G BAND Band DOHS 4305011 Knight Galina 9 2016
C BAND Band DOHS 4305012 Arnold Guiliana 9 2016
G BAND Band DOHS 4305013 Harper Gaby 9 2016
C BAND Band DOHS 4305014 Lawson Gabriel 9 2016
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List of Students Without Disciplinary Incidents

Navigation: Studentinformation — EZ Query — Reports — Students Without Disciplinary
Incident

You can view and download a list of all students without any disciplinary incidents.

1. On the List Of Students Without Disciplinary Incidents screen, in the drop-down list,
select the school.

Select whether you want to view only Active Students or All Students.

(Optional) Select your file download options.

Note: If you do not select any file download options, the list displays at the bottom
of the screen.

4. Click View Summary.

Studentinformation = EZ Query > Reports > Students Without Disciplinary Incident

List Of Students Without Disciplinary Incidents

|ASHLAND HIGH SCHOOL V|© Active Students (O All Students

&3 File Download Options

| Select A File Type | | Select A Download Method -

View Summary

The students with no disciplinary incidents who match your search criteria display in a
report or on the screen, based on your selections.
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Students Without Disciplinary Incidents —

Viewed on Screen

Studentinformation > EZ Query > Reports > Students Without Disciplinary Incident

List Of Students Without Disciplinary Incidents

|SADOC High School v|© Active Students O All Students

&3 File Download Options

| Select AFile Type | |Select A Download Method

| View Summary ‘

Student ID School Code First Name

4304027 DOHS Arpad
4314024 DOHS Taylen
4305029 DOHS Gram
4310015 DOHS Calypso
4303013 DOHS Ivana
4308013 DOHS Marc
4305012 DOHS Guiliana
4301014 DOHS Siri
4308023 DOHS Malcom
4305022 DOHS Gloria

Students Without Disciplinary Incidents — Download File

A B C

StudentlD Code Lastname

1

2 1224 DAHS LEE

3 4002 DAHS FONT

4 4003 DAHS JOHMSOM
& 4004 DAHS POTTS

] 4005 DAHS WWELLS

7 4008 DAHS SAWYER
g 8002 DAHS PERRY

a 5003 DAHS POTTS

10 5004 DAHS ZPRAT
11 5005 DAHS WELLS
12 B001 DAHS EYE
13 5002 DAHS FONT
14 B003 DAHS JONES
15 5004 DAHS LINE
16 B005 DAHS MAY
17 7003 DAHS RING

Last Name o Grade

Adkins 12
Aguilar 12
Alvarado 12
Alvarez 10
Andrews 10
Armstrong 10
Arnold 10
Austin 10
Baldwin 12
Ball 12

B

FirstName
HARPER
ELLA JANE
GEORGE EvAN
JORDAN DAMIEL
JOBETH
THOMAS
MICHAEL JAY
14N MICHAEL
JACK JOSERH
JOMA REMEE
CORY ROBERT
MICHELLE LYMM
WYHITREY AR
TROY AARCH
DAISY LEE
MICOLE SUZANME

E

Grade

9
12
12
12
12
11
1
11
1
11
10
10
10
10
10

9

Reports
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Weekday Attendance Percentage

Navigation: Studentinformation — EZ Query — Reports — Weekday Attendance Percentage

You can view a school’s absence and tardy percentages broken out by day of the week so you
can track student absence trends.

1. Onthe Weekday Attendance Percentage screen, in the drop-down list, select the school
for which you want to view absence or tardy percentages.

(Optional) Select a Grade and/or Gender to filter results by those criteria.
For the Absence Type option, select whether to display Absent or Tardy percentages.

Click Display.

Studentinformation > EZ Query > Reports > Weekday Attendance Percentage

Weekday Attendance Percentage
| SADoc High School ~| Grade| v Genue

Absence Type: @ Absent O Tardy

' Display '
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The absence or tardy percentages for the school and school year in context display in a
bar graph and chart showing each day of the week and the attendance or tardy

percentage.

Studentinformation = EZ Query = Reports > Weekday Attendance Percentage

Weekday Attendance Percentage

| SADoc High School ~| Grade|

v| Gender| v|

Absence Type: @® Absent (O Tardy

Display

100
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